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This document is copyrighted with All Rights Reserved. Under copyright laws, this 
document must not be copied in full or in part, or reproduced by any other media, 
without the express written permission of Coherent, Corp. (Coherent). Permitted 
copies must have the same proprietary and copyright notices as were attached to 
the original. This exception does not permit copies—whether or not sold—to be 
made for others;

however, all the material purchased can be sold, given, or loaned to another person. 
Under the law, “copying” includes translation into another language.

Coherent, the Coherent Logo, and the LabMax Pro SIMM are registered trademarks of 
Coherent, Corp. All other trademarks or registered trademarks are the property of their 
respective owners.

Patents referenced in this manual are active when the manual is printed (see last page 
for the date). You are advised to check if the patents are still active www.coherent.com/
legal/patents.

Every effort was made to make sure that the data shown in this document is accurate. 
The information, figures, tables, specifications, part numbers, and schematics 
contained in this manual are subject to change without notice. Coherent makes no 
warranty or representation, either expressed or implied, related to this document. In no 
event will Coherent be liable for any direct, indirect, special, incidental, or consequential 
damages caused by any defects in its documentation.

Technical Support

In the U.S.:

Should you experience any difficulties with your laser or need any technical information, 
please go to our web site www.Coherent.com. Should you need further assistance, 
p lease  con tac t  Coheren t  Techn ica l  Suppor t  by  e -ma i l 
customer.support@coherent.com or telephone, +1-734-456-3100. Please be prepared 
to supply the model and laser head serial number of your laser system,   the description 
of the problem, and any attempted corrective steps to the Product Support Engineer 
responding to your request.

Telephone coverage is available Monday through Friday (except U.S. holidays and 
company shutdowns). Inquiries received outside of normal office hours will be captured 
by our automatic answering system and will be quickly returned the next business day.

Outside the U.S.:

If you are located outside the U.S., please visit www.Coherent.com for technical 
assistance, or contact your local Service Representative. Service Representative 
telephone numbers and addresses can be found on the Coherent web site.

Coherent provides telephone and web-based technical assistance as a service to its 
customers and assumes no liability for any injury or damage that can occur at the same 
time with such services. Under no conditions do these support services affect the terms 
of any warranty agreement between Coherent and the buyer. Operation of any 
Coherent laser with any of its interlocks defeated is always at the operator's own risk.

© Coherent, Corp. 2013–2023. All rights reserved.
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1

1 Introduction

1.1 Signal Words and Symbols in this Manual

This documentation may contain sections in which particular hazards are
defined or special attention is drawn to particular conditions. These
sections are indicated with signal words in accordance with ANSI Z-535.6
and safety symbols (pictorial hazard alerts) in accordance with ANSI Z-
535.3 and ISO 7010.

1.1.1 Signal Words

Four signal words are used in this documentation: DANGER, WARNING,
CAUTION and NOTICE.

The signal words DANGER, WARNING and CAUTION designate the
degree or level of hazard when there is the risk of injury:

DANGER!
Indicates a hazardous situation that, if not avoided, will result in death
or serious injury. This signal word is to be limited to the most extreme
situations.

WARNING!
Indicates a hazardous situation that, if not avoided, can result in death
or serious injury.

CAUTION!
Indicates a hazardous situation that, if not avoided, can result in 
minor or moderate injury.

The signal word 'NOTICE' is used when there is the risk of property 
damage:

NOTICE
Indicates information considered important, but not hazard- related.
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Messages relating to hazards that can result in both personal injury and
property damage are considered safety messages and not property
damage messages.

1.1.2 Symbols

The signal words DANGER, WARNING, and CAUTION are always
emphasized with a safety symbol that indicates a special hazard,
regardless of the hazard level:

This symbol is intended to alert the operator to the presence of addi-
tional information.

This symbol is intended to alert the operator to the presence of
important operating and maintenance instructions.

This symbol is intended to alert the operator to the danger of expo-
sure to hazardous visible and invisible laser radiation.

This symbol is intended to alert the operator to the presence of
dangerous voltages within the product enclosure that may be of suffi-
cient magnitude to constitute a risk of electric shock.

This symbol is intended to alert the operator to the danger of Electro-
Static Discharge (ESD) susceptibility.
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1.2 Preface

This manual contains user information for the LabMax Pro SIMM.

NOTICE
Read this manual carefully before operating the laser for the first time.
Failure to follow the instructions and safety precautions in this
manual can result in serious injury or death. Special attention must be
given to the material in ’Safety and Compliance’ (p. 173), that shows
the safety features built into the laser. Keep this manual with the
product and in a safe location for future reference.

DANGER!
Use of controls or adjustments or performance of procedures other
than those specified herein may result in hazardous radiation expo-
sure.
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1.3 Export Control Laws Compliance

It is the policy of Coherent to comply strictly with U.S. export control laws.

Export and re-export of lasers manufactured by Coherent are subject to
U.S. Export Administration Regulations, which are administered by the
Commerce Department. In addition, shipments of certain components are
regulated by the State Department under the International Traffic in Arms
Regulations.

The applicable restrictions vary depending on the specific product
involved and its destination. In some cases, U.S. law requires that U.S.
Government approval be obtained prior to resale, export or re-export of
certain articles. When there is uncertainty about the obligations imposed
by U.S. law, clarification must be obtained from Coherent or an
appropriate U.S. Government agency.

Products manufactured in the European Union, Singapore, Malaysia,
Thailand: These commodities, technology, or software are subject to local
export regulations and local laws. Diversion contrary to local law is prohib-
ited. The use, sale, re-export, or re-transfer directly or indirectly in any pro-
hibited activities are strictly prohibited.
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2 Description and Specifications

This section introduces the Coherent Meter Connection (CMC) software.

• For information about the features and functions of the Coherent
Meter Connection software, see ’User Interface – Main Controls’
(p. 21).

• For information about taking measurements using Coherent meters
and sensors, see ’Measurement Modes’ (p. 141).

2.1 Product Features

The Coherent Meter Connection software offers an easy-to use Win-
dows-based interface to perform a wide range of analysis functions for in-
strument control and measurement. This includes:

• High-speed sampling modes up to 1 MHz

• Trending with Time and Power cursors

• Energy integration

• Tuning

• Data logging

• Statistics

• Histogram

2.1.1 Supported Products

The Coherent Meter Connection software supports Coherent sensors and
meters, shown in Figure 2-1.  

These devices offer a wide range of analytical functions, although some
software functions may be limited by the capability of the sensor. Support-
ed devices include:

• PowerMax®-Pro USB/RS power sensors

• PowerMax USB/RS power sensors
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• EnergyMax USB/RS energy sensors

• LabMax-Pro SSIM Laser Power and Energy Meter

• LabMax Touch and Touch Meter Pro Laser Power and Energy Meters

Shop.coherent is the official e-commerce website for lasers, energy me-
ters and sensors, fiber optics, and accessories. Available for US custom-
ers, the e-commerce service offers product search, product-specific
filtering, and fast-and-easy checkout with prompt order and shipping con-
firmations. 

2.1.2 System Requirements

It is recommended to use the most current and robust systems possible.
Support is provided for the following operating system:

• Windows  v10 (32- and 64-bit)

In addition, the workstation must meet the following minimum require-
ments:

• 4 GB of RAM

• 100 MB of available hard disk space

Figure 2-1.  Products Supported
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• 2.5 GHz or faster processor

• USB 2.0 high-speed port

• 1024x768 screen resolution

• Microsoft .NET Framework 4.0 or higher. If no version (or an older
version) is found on the workstation, then the installation program
installs a version of Microsoft .NET Framework.
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3 Installation

This section shows how to install the software application.

• For information about the features and functions of the Coherent
Meter Connection software, see ’User Interface – Main Controls’
(p. 21).

• For information about taking measurements using Coherent meters
and sensors, see ’Measurement Modes’ (p. 141).

3.1 Before Work is Begun

3.1.1 Administrative Privileges

In today’s world, it is a challenge for organizations to find a balance be-
tween implementing security requirements and managing the user experi-
ence.

Security processes and controls required to comply with industry-accept-
ed standards, regulations, and certifications can impose constraints on
user authentication and access. Such controls may block a software in-
stallation, making it appear as incomplete or non functional.

If there are difficulties with the BeamView.NET software installation, be-
fore you call Coherent Technical Support, check with your IT group first
to determine if:

• The user has the administrative privileges required to install a new
program.

• There are any internal security policies or controls in place that may
render installation of a new software package incomplete.

Another option is to right-click in Windows and select ‘Run as administra-
tor’. For any executable (.exe) files, Coherent recommends to use this
method for installation.  

After those issues are resolved, then see ’Maintenance and Support’
(p. 197) for details about how to contact Coherent for assistance.
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3.2 Installation Instructions

Before installation is started, remember to save any data and close all oth-
er applications. The installation requires that you restart the workstation
when installation is complete.  

To install the software:

1. Download the software from the Coherent website:
https://www.coherent.com/resources

NOTICE
The Coherent Meter Connection software is available in English only.

2. Run the set-up file, where the last two digits represent the current soft-
ware build: 
Coherent Meter Connection v1.2.x.x Release Setup.exe
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A Welcome screen like the one shown in Figure 3-1 is displayed for
the installation. If there is a previous version of the software installed,

the message shown in Figure 3-2 displays. Click Yes to proceed and
dismiss the dialog box.  

[

Figure 3-1.  Welcome Screen

Figure 3-2.  Uninstall Old Version of Software
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3. Read the instructions, and then click Next. The general License
Agreement for the software, shown in Figure 3-3, displays. 

4. Scroll down to read the general software agreement. Note that the
Next button is shown in gray until you click the radio button to Accept
the terms and conditions. The Next button is then active; click Next to
proceed.

Figure 3-3.  License Agreement
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5. A window like the one shown in Figure 3-4 displays. Accept the selec-
tion for the destination location or browse to select a directory on the
workstation where you want to install the software, and click Next.

6. Select a directory on the workstation for the Start Menu where the
program is to be installed, as shown in Figure 3-5. Accept the selec-
tion or browse to a different location, and then click Next.

Figure 3-4.  Select Directory to Install Software

Figure 3-5.  Select Start Menu Folder
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7. To create an icon for a shortcut to the application on the desktop, click
the check box, as shown in Figure 3-6, and then click Next.

The Set-up Wizard is now ready to begin installation of the Coherent
Meter Connection software on the workstation. Review the settings,
as shown in Figure 3-7, and then click Install.  

Figure 3-6.  Create Desktop Icon

Figure 3-7.  Review Set-Up before Installation Begins
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On initial set-up, a message similar to the one shown in Figure 3-8
displays. 

8. Click the check box to ‘Always trust software from ‘Coherent, Corp.’
and click Install. Device drivers included with the Coherent
Meter Connection software are added to the installation. 

NOTE: On later installations of the software, the dialog box about
device drivers is not displayed.

A progress bar displays as files are extracted, as shown in Figure 3-9. 

Figure 3-8.  Install Coherent Device Drivers

Figure 3-9.  Progress of Installation
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9. After all files are extracted, the screen shown in Figure 3-10 is
displayed. Click Finish, to close the installation window.  

The Coherent Meter Connection software is now installed and the
software is ready to be launched. 

If you selected a short-cut (icon) to be set up during installation, it is
now displayed on the workstation desktop, as shown in Figure 3-11:  

Figure 3-10.  Finish Software Installation

Figure 3-11.  Desktop Icon for Coherent Meter Connection
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10. Double-click the icon to launch the Coherent Meter Connection soft-
ware. A splash screen displays, like the one shown in Figure 3-12:

3.3 Next Steps

Now that the software is installed:

• Connect the equipment.

• Go to ’User Interface – Main Controls’ (p. 21) to learn about the
features and functions of the user interface.

3.3.1 Connect the Equipment

The Coherent sensor must be connected to a workstation or directly to a
meter. 

Figure 3-12.  Splash Screen on Launch
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3.3.1.1 Connect Coherent Connection Meterless USB or RS Sensor to Worksta-
tion

To attach a sensor to a meterless USB or RS sensor, do the following:

1. Connect the Coherent sensor to a USB 2.0 port on a workstation. 
When using a Coherent RS-232 meterless sensor, connect the 
RS-232 cable directly to its corresponding serial port on a PC. 

2. A power supply is required when an RS-232 meterless sensor is
used. A power supply is optional for a USB sensor. Connect the
cables and plug the power supply into an outlet.

3. Start the Coherent Meter Connection software, and then select the
COM port for the sensor.

3.3.1.2 Connect Coherent Sensor with DB-25 Connector to a LabMax Meter

To attach a sensor to a LabMax Pro SIMM or LabMax Touch Meter, do the
following: 

1. Attach a Coherent sensor with a DB-25 connector to the LabMax-Pro
SIMM or LabMax Touch/Touch Pro meter.

2. Attach the meter to a workstation with a USB 2.0 cable.

Figure 3-13.  Sensor Installation
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3. If the meter supports ethernet (LabMax Touch) and ethernet connec-
tion is to be used, do the following:

a.) Attach the ethernet cable to the ethernet port on the PC. Refer
to Figure 3-14.

b.) Attach the other end of the ethernet cable to the ethernet port on
the meter.

4. To complete ethernet setup, refer to the LabMax Touch Meter Oper-
ator’s Manual. Connect the power supply to the LabMax-Pro SIMM or
LabMax Touch/Touch Pro meter.

5. Set the power on the meter to ON. Start the Coherent Meter Connec-
tion software, and select the COM port for the LabMax-Pro meter.

Figure 3-14.  Connect a LabMax Touch Meter to a PC with USB
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Refer to the figures below for examples of setup for the LabMax Pro SIMM
and for the LabMax Touch/Touch Pro meters.

Figure 3-15.  Connect a LabMax Pro SIMM Meter 

Figure 3-16.  Connect a LabMax Touch Meter to a Sensor
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4 User Interface – Main Controls

This section introduces the Coherent Meter Connection software, an
easy-to-use interface that runs on a workstation. (Note: Workstation is the
term used throughout this manual to refer to either a personal computer
(PC) or a laptop computer.)

The components of the Main Window of the user interface include:

• ’Quick Start Icons’ (p. 23)

• ’Drop-Down Menu’ (p. 25)

For more details about the user interface, see:

• Tabs and toolbars across the top of the Main Window (p. 39)

• Viewing panels in the window (p. 77)

• Statistics Panel (p. 125)

• Tutorials about options to take measurements (p. 141)
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4.1 Main Window

When you first launch Coherent Meter Connection, the splash screen is
briefly displayed, then Main window is displays (shown in the example in
Figure 4-1).  

The main window of the software displays quick start icons and informa-
tion across the top of the window, plus a main drop-down menu. The
tabbed areas in the tool bar and tabbed windows below the Graphics Pan-
el display controls that are readily available.

Figure 4-1.  Coherent Meter Connection—First Window
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4.1.1 Quick Start Icons

Figure 4-2 shows the row of quick start icons at the top of the Window.
These icons are similar to commands in the drop-down menu or in the tool
bars. 

Table 4-1 shows these icons and a brief description of each. The descrip-
tion also lists any alternate locations in the software for the same com-
mand. 

4.1.2 Top of the Window

Figure 4-3 shows data displayed across the top of the window: 

Figure 4-2.  Coherent Meter Connection—Quick Start Icons

Table 4-1.  Quick Start Icons

Icon Description Same function as…

Access to Windows 
system menu

Includes standard Windows actions: 
Restore, Move, Size, Minimize, Maximize, 
and Close.

Opens a COM port 
connection to the meter

Drop-down menu > Open Meter command.

Clear the contents of the 
Capture Buffer

Drop-down menu > Meter Operation > 
Clear Buffer command.
Also on the Home Tab > Clear icon.

Measure the sensor’s 
zero baseline

Drop-down menu > Meter Operation > 
Zero Meter command.
Also on the Home Tab > Zero icon.

Start streaming 
measurements

Drop-down menu > Meter Operation > 
Start Measurements command.
Also on the Home Tab > Start icon.

Stop streaming measure-
ments

Drop-down menu > Meter Operation > 
Stop Measurements command.
Also on the Home Tab > Stop icon.
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Table 4-2 shows each item displayed, with a brief description of the data:  

The drop-down menu at the very top of the window displays the available
wavelengths, as shown in the example in Figure 4-4.  

Figure 4-3.  Data at Top of Main Window

Table 4-2.  Data Across Top of Window

Option Example in 
Figure 4-3 Description

Wavelength 400 nm Drop-down menu that displays the current 
wavelength

Software Coherent 
Meter Connec-
tion v1.2.x.x

Lists the current version of the software and the 
build number, where the last two digits repre-
sent the current build

Sensor DB25 HBE 2 Identifies the type of sensor attached to the 
meter

COM Port COM4: SSIM 
# “0639B14R”

(Displayed under the top line) Identifies the 
COM port as well as the meter and serial 
number

Figure 4-4.  Quick Start —Laser Wavelength
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If the wavelength for the laser being used is not visible, enter it in the list
by either typing it directly or editing the Wavelength Table (see p. 57). The
wavelength point you enter must be inside the normal range of operation
for the sensor.

4.1.3 Drop-Down Menu

The drop-down menu in Figure 4-5 manages standard functions for the
software.  

The drop-down menu includes a variety of functions and settings:

• Open Meter

• Close Meter

• Meter Operation
(Start | Stop | Clear | Zero)

• Import/Export
(Settings | Import | Export | Reports | Data Logging)

• View
(Error Log | Limits & Alarm | Pulse Analysis Wavelength Table)

• Help

• About

Figure 4-5.  Coherent Meter Connection—Drop-Down Menu
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• License Manager (Add | Manage Certificates)

• Check for Updates

• Exit

Each of these functions are shown in the sections that follow.

4.1.4 Open Meter

Selecting the Open Meter icon from the drop-down menu displays a dialog
box, like the one shown in Figure 4-6:  

From the drop-down menu, select the appropriate communications port
for the meter, as shown in the example in Figure 4-7:  

4.1.5 Close Meter

Selecting the Close Meter icon from the drop-down menu closes the me-
ter. The software is still active. 

To continue taking measurements, you must first select a meter using the
Open Meter command.

Figure 4-6.  Drop-Down Menu—Open Meter

Figure 4-7.  Drop-Down Menu—Open Meter Selections
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4.1.6 Meter Operation

Selecting the Meter Operation option from the drop-down menu displays
the options shown in Figure 4-8:  

Table 4-3 briefly shows each option:  

Figure 4-8.  Drop-Down Menu—Meter Operation

Table 4-3.  Meter Operation Commands

command Description

Zero Meter Zero the meter. This is done by reading measurements 
to establish a baseline (zero level) for all ranges. 
To ensure a valid calibration, cover the sensor during 
this operation.

Start Measure-
ments

Begins sending measurement data from the meter, using 
the current settings. Most operating controls are disabled 
while acquisition is in progress. Data is saved and 
displayed in the user interface.

Stop Measure-
ments

Stop the meter from sending measurement data. Data 
that has been collected may be viewed in the user inter-
face.

Clear Buffer Clears all data in the Capture buffer.
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Selecting the Zero Meter command displays the dialog box shown in
Figure 4-9:  

This command automatically calibrates all ranges for the current sensor. 

Changing sensors, changing modes, and switching between High-Speed
and Standard Speed all require zeroing the instrument. Selecting Zero Me-
ter zeros both channels in a single operation if the sensor supports both
High-Speed and Standard Speed.

Figure 4-9.  Drop-Down Menu—Zero Meter
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4.1.7 Import-Export

Selecting the Import-Export option from the drop-down menu displays the
commands shown in Figure 4-10:  

The Import/Export options allow you to manage files and settings, as well
as enable logging and restore system defaults. When you import or ex-
port, the standard desktop window is displayed. Browse to the location
you want to use.

Table 4-4 shows the Import/Export icons and a brief description of each.  

Figure 4-10.  Drop-Down Menu—Import/Export Selections
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Table 4-4.  Import-Export Commands

Command Description

Import Data Import captured data to the Acquisition Buffer from 
an external file. You will be prompted to specify a 
source file name using one of these 
formats: .csv, .tsv or .txt.

Export Data Exports (saves) all captured data in the Acquisition 
Buffer to an external file. You are prompted to 
specify a destination file name using one of these 
formats: .csv, .tsv or .txt.

Import Settings Allows a user to load parameters that were previ-
ously saved (exported) to an external file.

Export Settings Allows the user to adjust parameters and save for 
future use. Saves the settings to an external file 
using one of these formats: .csv, .tsv or .txt.

Import Pulse Analysis 
Settings

Loads applications settings for Pulse Analysis that 
were previously saved (exported) to an external file.

Export Pulse Analysis 
Settings 

Saves the application settings for Pulse Analysis to 
an external file.

Export Pulse Analysis 
Report

Saves the application settings for Pulse Analysis to 
an external file.

Export Statistics Report Saves the application settings for Statistics to an 
external file.

Enable Logging Toggles the Data Logging feature. Displays whether 
the feature is enabled.

Data Logging Settings Launches the Data Logging dialog box. For details, 
see p. 44.

Restore System Defaults Resets all internal settings to factory default.
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4.1.8 View Command

Selecting the View option from the drop-down menu displays the options
shown in Figure 4-11:  

The check boxes for panels at the top of the View menu allow you to dis-
play or hide the various areas in the window. These check boxes are also
listed under the View tab (in the Visible Panels section of the toolbar).

The menu options for System Information, I/O Transcript, and Error Mes-
sages are also available under the View menu (Visible Windows section of
the toolbar).

For more details about these options, see ’User Interface – Tabs’ (p. 39). 

• For Limits & Alarm Settings, see ’Limits & Alarms Settings…’ (p. 32).

• For Pulse Analysis Settings, see ’Analysis Options’ (p. 99).

• To change the Wavelengths Table, see ’Edit Wavelength Table’
(p. 57).

Figure 4-11.  Drop-Down Menu—View Selections
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Table 4-5 lists the icons and a brief description of each under the View
command.  

4.1.8.1 Limits & Alarms Settings…

Particularly when working with sensitive equipment, the Limits & Alarm
settings help users track measurements and make sure sample is inside
the operating range. 

The Limits & Alarm License generates fault actions if the power or energy
output goes outside a set limit (choose to display reverse color on-screen,
stop data collection, and/or sound an audible alarm).

Selecting Limits & Alarm Settings from the View command in the main
drop-down menu first displays a notice. This dialog box allows you to
alarms to notify you when minimum and maximum limits are reached.
Note that Maximum values are not enforced.  

Table 4-5.  View Commands

Command Description

Measurement Panel Check boxes open or close the three primary panels 
in the user interface. Only one out of any of the three 
panels must be displayed; any of the two other panels 
may be hidden at the same time.

Graphics Panel

Statistics Panel

Show System Info Displays a window that lists details about the system 
set-up for the meter and the attached sensor. This is 
useful when contacting Coherent Product Support.

Show IO Transcript Displays a window showing the traffic between the 
meter and the PC application.

Show Error Log Displays a window showing all error messages 
received so far in the current session. This window 
pops up automatically if an error is reported. 

Limits & Alarms 
Settings…

Displays a dialog box to set notifications for values 
when taking power measurements (see p. 32). Note 
that Maximum values are not enforced.

Pulse Analysis 
Settings…

Displays a window to edit the entries of the pulse 
analysis settings.

Edit Wavelengths Table Displays the Wavelength Table to edit the entries of 
the wavelength compensation table. 
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 The Limits & Alarms dialog box is shown in Figure 4-12: 

The Available Statistics area lists the measurement being taken (Power or
Energy).

Click the check box for “Perform Pass/Fail checking” to enable Limits &
Alarms. Any minimum and maximum values that you set are not used in
any measurement sample until you click this check box.

You can change and set both the Minimum and Maximum values. The val-
ues you enter must be a positive number.

If you enter a negative number or values that exceed minimum levels for
the device, an error message is displayed until you correct the setting.
The Save button is disabled if an invalid value is entered.

Maximum thresholds are not enforced.

• In some cases, sensors can take higher power levels in excess of the
maximum rating for short periods of time; however, the longer the
exposure, the lower the level needs to be. (See the Coherent Laser
Measurement and Control product catalog, which shows a chart of
‘exposure limits vs. power’ for various lasers.)

• In other cases, optional gain settings may be applied to measure-
ments to cause a meter to report a higher power exposure.

Figure 4-12.  Limits & Alarms – Dialog Box
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Select the scale for these values from the drop-down menu in the dialog
box, as shown in Figure 4-13:  

Clicking Fault Actions displays the pop-up dialog box shown in Figure 4-14.
Select any or all of these types of notification that you want to receive
when limits are exceeded:

• Stop Acquisition

• Beep

• Reverse Background Color  

Figure 4-13.  Limits & Alarms – Scale

Figure 4-14.  Limits & Alarms – Fault Notifications
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Click the check boxes for the alarms and notifications options you want
(shown in Table 4-6), then click OK.  

After Fault Alarm sis selected in the Limits & Alarms dialog box, either:

• Click Discard in the dialog box to revert to any previous settings
that you entered.

• Click Save in the dialog box to retain the settings you entered,
which closes the dialog box.

A link to the dialog box is put on the top of the Statistics Panel, as shown
in Figure 4-15. This link is displayed only if the Limits & Alarms are en-
abled.  

To open the Limits & Alarms dialog box, either click this link or use the
main drop-down menu (View > Limits & Alarms). 

Table 4-6.  Limits & Alarms – Fault Settings

Option Description

Stop Acquisition Continues a running count in the Buffer Statistics panel 
unless this box is checked. Note that the sample count 
displayed at the bottom right of the window shows a 
different sample count unless you select the Stop Acqui-
sition option.

Beep Generates an audible notification with a beeping sound to 
alert you to an out-of-range situation. 

Reverse Back-
ground Color

Reverses the background color of the display in the 
Graphics Panel.

Figure 4-15.  Limits & Alarms – Link at Top of Statistics Panel
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Notifications are displayed in the Main window in several locations, as
shown in Figure 4-16.  

4.1.9 Help

Selecting the Help option from the drop-down menu launches the viewer
for embedded Help files for the Coherent Meter Connection software. 

This information is also repeated in the toolbar by clicking the Help ( )
icon.

4.1.10 About

Selecting the About option from the drop-down menu displays information
about the software and the company, like the one shown in Figure 4-17. 

. 

Figure 4-16.  Limits & Alarms – Notifications in Main Window



User Interface – Main Controls 

37

This information is also repeated in the toolbar by clicking the Information
( ) icon.  

The dialog box includes a Check for Updates button.

4.1.11 Check for Updates

When the Check for Updates is selected from the main drop-down menu,
the dialog box shown in Figure 4-18 displays:  

Figure 4-17.  About Dialog Box

Figure 4-18.  Check for Software Updates
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If versions display in the list of any later software releases, and select the
version you want to install by clicking on that line. Click Select to display
the next window (Figure 4-19):  

Click Download.  The window displays a progress bar (Figure 4-20).  

4.1.12 Exit

Select the Exit option from the drop-down menu to exit the Coherent Me-
ter Connection software application and close the window.

Figure 4-19.  Check for Software Updates – New File

Figure 4-20.  Check for Software Updates – Download File
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5 User Interface – Tabs

This section introduces the Coherent Meter Connection software, an
easy-to-use interface that runs on a workstation. (Note: Workstation is the
term used throughout this manual to refer to either a personal computer
(PC) or a laptop computer.)

Tabs and tool bars across the top of the window include:

• ’Home Tab’ (p. 39)

• ’Data Buffer Tab’ (p. 50)

• ’Measurement Tab’ (p. 56)

• ’Trigger Tab’ (p. 63)

• ’Data Buffer Tab’ (p. 50)

5.1 Home Tab

The first tab in the tool bar ribbon is the Home tab, shown in Figure 5-1:  

The Home tab includes the sections that follow:

• Sensor Identification (Type | Model | Serial Number)

• Operating Mode (Mode | Range | High-Speed Selection)

• Acquisition (Start | Stop | Data Logging)

• Data Buffer (Import | Export | Clear)

• Calibration (Zero)

Each of these areas are shown in the sections that follow.

Figure 5-1.  Home Tab in Toolbar
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5.1.1 Sensor Identification

Figure 5-2 shows the Sensor area on the Home tab: 

This section displays the properties of the currently connected sensor, in-
cluding the type, model, and serial number of the current sensor.

If a sensor cannot be found (such as if not attached to the PC), the fields
show ‘None’. Note that the Model number is also listed at the top of the
application window.

5.1.2 Operating Mode

Figure 5-2 shows the Operating Mode section on the Home tab.  

These are selectable: 

• Mode

• Range

• High-Speed Mode (also used for Snapshot Mode)

NOTE: When High-Speed Mode is not checked, the meter samples
the power channel at a rate of 10 Hz. 

Figure 5-2.  Home Tab – Sensor Information

Figure 5-3.  Home Tab – Operating Mode Settings
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5.1.2.1 Mode

This command selects the primary measurement to be performed by the
meter, as shown in Figure 5-4.  

• Power Watts — Measure power in Watts.

• Energy Joules — Measure energy in Joules.

5.1.2.2 Range

Figure 5-5 shows the drop-down menu on the Home Tab used to select
the full-scale operating range of the meter.  

Table 5-1 shows these options: 

Figure 5-4.  Home Tab – Select Mode

Figure 5-5.  Home Tab – Select Range
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5.1.2.3 High-Speed Mode

The check box for High-Speed Mode shown in Figure 5-6 enables or dis-
ables High-Speed Mode. Click this check box to start High-Speed data ac-
quisition at a 20 kHz sampling rate.  

High-Speed Mode is available when using PowerMax-Pro technology and
pyroelectric energy sensors. When used with PowerMax-Pro sensors, this
mode is typically used to analyze modulated lasers with pulse lengths
greater than 10 microseconds. Some sensors can only operate at a single
speed, in which case the check box is shown in gray, and the check box
indicates only the allowed speed.

Data acquisition can occur at High-Speed (approximately 20K sam-
ples/second) or standard speed (approximately 10 samples/second).
While High-Speed acquisition acquires samples faster than Basic-Speed
acquisition, the numerical resolution is lower. High-Speed Mode is re-
quired when using Snapshot Mode.

Table 5-1.  Operating Mode Options

Option Description

AUTO Instructs the meter to adjust ranges (upward or downward), 
depending on the signal level. AUTO is not allowed for certain 
operations, such as when taking measurements in Stan-
dard-Speed or when using Snapshot Mode.
• Some operating modes support an Auto Range option, in which case

the meter changes ranges automatically to maximize accuracy and
prevent Over Range.• When measurements exceed the operating range, the corresponding 
samples are flagged as Over Range.

Ranges 
Available

The specified ranges available depend on the sensor connected 
and the selected operating mode. Determined by individual 
sensor and meter. 

Figure 5-6.  Home Tab – Check Box for High-Speed Mode
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5.1.3 Acquisition

Figure 5-7 shows the Acquisition section on the Home tab. Acquisition
commands include the Start, Stop and Data Logging icons. 

5.1.3.1 Start

This command begins sending measurement data from the meter. The
data is saved and displayed by the User Interface. The same Start icon is
available at the top of the window in the Quick Start section, as shown in
Figure 5-8.  

5.1.3.2 Stop

This command stops the meter from sending measurement data. Data
that has been collected may be viewed in the User Interface or saved to a
file. 

The same Stop icon is available at the top of the window in the Quick Start
section, as shown in Figure 5-9.  

Figure 5-7.  Home Tab – Data Acquisition Controls

Figure 5-8.  Home Tab – Start Icon
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5.1.3.3 Data Logging

On the Home Tab, the Data Logging icon toggles the Data Logging feature
on and off. This feature is also available in the Data Logging Settings dia-
log box, displayed when you click the Data Logging icon.

The Data Logging Button toggles the Data Logging feature; click once to
toggle the feature on or off.

When Data Logging is enabled, the icon is highlighted in the toolbar, as
shown in Figure 5-10. Whenever logging is enabled, the button's back-
ground is highlighted to give a clear indication that logging is enabled.  

This feature can be enabled or disabled whether the meter is stopped or
running; however, actual data logging can only be performed when the
meter is acquiring data, and then only if logging is enabled when the user
clicks Start. Currently, it is not possible to toggle logging while the meter is
running.

After this setting is enabled, data logging begins when the Start button is
clicked and continues until the meter stops or you manually set the feature
to off while the meter operates.

Various logging options are controlled by the Data Logging Settings dialog
box. Right-click on the Data Logging icon to display a context menu,
shown in Figure 5-11.  

This menu allows users to examine and modify the Settings, and provides
another way to toggle logging on or off.

Figure 5-9.  Home Tab – Stop Icon

Figure 5-10.  Home Tab – Data Logging Icon
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• Select Enable Logging to toggle the logging feature ON or OFF.

• Select Data Logging Settings to display the dialog box shown in
Figure 5-12, with the options that follow provide explicit control over
settings.

Settings in this dialog box are shown in the sub-sections that follow.

After you select options:

• Click OK in the dialog box or press Enter on the keyboard to confirm
changes to the settings in the dialog box.

• Click Cancel makes no changes; the original setting remains
unchanged.

Figure 5-11.  Home Tab – Data Logging Context Menu

Figure 5-12.  Home Tab – Data Logging Settings Dialog Box
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5.1.3.3.1 Enabled

The button at the top of the dialog box shown in Figure 5-12 clearly shows
whether Data Logging is currently enabled. 

• Click the Enabled button in the dialog box to toggle the Data Logging
feature on and off (this provides the same functionality as the button
on the Home Tab).

5.1.3.3.2 Log File Destination

Select the file name and path to be used for the destination of a log file:

• Path: Displays the currently selected destination file path for the data
log.

• Browse button:

• Click this button to view a File Create dialog box.

• Browse to the needed location where to store the destination log
file.

Data Logging stores acquired data into an external file. Each time the me-
ter starts, a new log file needs to be created. 

Several recovery alternatives are provided when the specified file name
already exists, listed in Table 5-2.  

Table 5-2.  Destination Log File — Name Conflict Resolution

Option Description

Overwrite 
existing file

The same file is overwritten each time the user presses Start. 
The previous data is overwritten, and only the most recent run 
is preserved.

Make update to 
destination file

The same file name is re-used each time the user presses 
Start, but the new data is added to the file’s previous 
contents.

Create specific 
new name

A specific new Destination Filename is created each time the 
user presses Start. The specific name is created by adding 
different successive, numeric suffixes or by modifying the 
name until a file name does not conflict with previous names.
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5.1.3.3.3 Log File Field Delimiter

The Destination log file is formatted exactly the same as regular Im-
port/Export files. This option determines the extension used on the log file
name; choose between the supported file formats listed in Table 5-3:  

5.1.3.3.4 Data Reduction

Data logging can create very large files, particularly when using high ac-
quisition speeds.

Users typically do not want to save logs for every single sample. Each
data record is approximately 50 bytes. Therefore, at an acquisition speed
of 20 kHz, this translates to approximately 1 Mb per second (or 60 Mb per
minute), so can quickly fill smaller hard drives.

To reduce or summarize the collected data, select one of the options listed
in Table 5-4: 

Table 5-3.  Destination Log File — Supported File Types

Option Description

Comma (.csv) Data records are encoded using Comma-Separated fields (“,”), 
often used in applications in the U.S. and other countries.

Tab (.tsv) Data records are encoded using Tab-Separated fields (“\t”), 
often used in applications in Europe and other countries.

Table 5-4.  Destination Logging — Data Reduction

Option Description

Keep All Samples Data reduction is set to off and the log file contains all 
the samples collected by the meter. Remember that, at 
high speeds, the log file can grow to an enormous size.

Keep One Sample 
Every … 
(By Elapsed Time)

This data reduction mode discards samples most of the 
time, and retains only a single sample at regular time 
intervals that you choose (for example, one sample per 
30 seconds or one sample per minute or hour).

Keep One Sample 
Out of Every
(By Sample Count)

This data reduction mode discards samples most of the 
time, retaining only every nth sample that you define 
(such as one sample out of every 1000 or 20000).
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5.1.3.3.5 Skipped Samples

Skipped samples may be ignored, or they may be averaged together.

Table 5-5 shows the options for skipped samples:  

5.1.4 Data Buffer

The meter collects data into a single Capture Buffer. This is a circular buf-
fer, which means that data is added to the buffer and after a point, the old-
est items are removed. When the meter stops, only the most recent
samples are saved.

The Data Buffer section of the Home Tab includes the icons shown in
Figure 5-13. This section displays the icons to manage the Data Buffer,
whereas the Data Buffer tab on the toolbar defines the settings for the
data files to be captured.  

Use the icons shown in Table 5-6 to manage the data buffer files.  

Table 5-5.  Destination Logging — Skipped Samples 

Option Description

Averaged Together The various fields of Skipped Samples are averaged 
together. Each entry in the log file shows the arithmetic 
mean of all the samples in the Reduction interval, such as 
the Flags field the logical OR of all the Flags fields.

Discarded Skipped samples are simply ignored, and have no effect 
on the log file contents. 

Figure 5-13.  Home Tab — Data Buffer Section
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5.1.5 Calibration

The Calibration section of the Home Tab displays the Zero icon, shown in
Figure 5-14. Clicking the Zero icon in the Quick Access tool bar gives the
same results. 

This command measures the zero baseline for the sensor in all possible
ranges. This action does not affect any data, statistics, or analysis results.
To make sure that calibration is valid, cover the sensor during this opera-
tion.

Table 5-6.  Data Buffer Icons

Option Description

Import When import data is imported to the Acquisition Buffer from an 
external file, you are prompted to specify a source file name.
Loads the acquisition from an external file. Clicking the Import icon 
displays the standard desktop directory. Select the desired file format 
from the drop-down menu, and browse to the location for the file you 
want to import. 

Export When data is exported in the Acquisition Buffer to an external file, you 
are prompted to specify a destination file name.
Saves all data in the acquisition to an external file. Clicking the Export 
icon displays the standard desktop directory. Select the desired file 
format from the drop-down menu, and browse to the location where 
you want to save the file.

Clear Discards all captured data in the data acquisition buffer in
preparation for acquiring new measurements.

Selecting the Clear icon also clears the Trending window and
removes any chart data, analysis markers, cursors, and other
annotations, as well as resets the Statistics Panel. After Clear is
selected, the icon is active in the toolbar.

Click the Clear icon in the Quick Access tool bar for the same
results.

Figure 5-14.  Home Tab — Calibration Section/Zero Icon
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CAUTION! 
Remember to block the laser beam before Zero is clicked.

Click the Zero icon to display the progress box shown in Figure 5-15:  

5.2 Data Buffer Tab

All acquisition sample data are ultimately collected in the Data Buffer,
which is also the destination for data acquired by the meter. The buffer is
also the destination or source, respectively, for data Imported from or Ex-
ported to an external data log file.

Selecting the Data Buffer tab displays the toolbar shown in Figure 5-16: 

The Data Buffer is a circular buffer. That is, although it has a finite capaci-
ty, it can record data continuously. When the buffer reaches its capacity,
older samples are discarded to make room for new ones. No matter how
long data acquisition continues, the Data buffer always holds a fixed num-
ber of the most recent samples.

The Coherent Meter Connection software maintains a separate buffer to
display progress of the data acquisition. The Data Buffer collects all the
acquisition data, but a separate Preview buffer periodically refreshes the

Figure 5-15.  Zero Meter Drop-Down Menu

Figure 5-16.  Data Buffer Tab
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user interface with just a subset of the most recent data. While data collec-
tion is in progress, only data captured inside the Preview buffer is dis-
played in the Trending chart.

After data collection ends (either by filling the Acquisition buffer or by hit-
ting Stop while in Continuous Mode), the Trending chart displays the en-
tire contents of the Capture buffer.

5.2.1 Data Acquisition Settings

In the section for Data Acquisition Settings, set options for Capacity and
Pre-Trigger values, Mode, and a preview by Sample Count and Update
Period (see Table 5-7):  

Durations are a convenient alternative to sample counts, though the un-
derlying value is actually a sample count. As such, durations are rounded
to the nearest multiple of 1 μSECS, the smallest sample period in Snap-
shot Mode.

Durations can have a range, for example from 0 to 384000 μS. There are
further restrictions that capacity duration must be ≥ 1 μSECS Also,
pre-trigger duration must be ≤ the capacity. Refer to the respective user
manuals for the meter being used for specific duration limits.

For Snapshot Mode, Capacity and Pre-Trigger settings can be specified
as durations in μSECS.

Table 5-7.  Data Acquisition Settings

Option Description

Capacity Controls the overall number of samples to collect in the Data 
Buffer.

Pre-Trigger The number of samples to collect before the first trigger event.

Mode Select the measurement mode (see more on p. 41):
• Continuous
• Wait Trigger
• Snapshot
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5.2.1.1 Buffer Capacity

Capacity controls the overall number of samples to collect (the size of the
Capture Buffer). Only the specified number of the most recent data sam-
ples are saved during data acquisition, though you can stop acquisition
before the entire buffer is filled.

Capacity may be specified by entering a sample count, a duration, or us-
ing a slider control. The maximum value is <Text>.

If you click the check box for Snapshot Mode, the Capacity setting deter-
mines the total number of samples to be collected in a single Snapshot.
The limits are:

1 ≤ Capacity ≤ Snapshot maximum

5.2.1.2 Pre-Trigger Offset

Data Acquisition may be configured so that a portion of the data acquired
before the first trigger event can be included in the capture buffer.
Pre-Trigger is allowed only for power sensors using High-Speed Mode or
Snapshot Mode.

The Pre-Trigger setting determines how many samples to collect before
the first trigger event. Pre-Trigger size may be specified by entering a
sample count, a duration, or using a slider control. 

The data collected in Snapshot Mode may be partitioned into two sections:
those samples that occurred before the trigger event, and those samples
that came afterwards.

• If Pre-Trigger = 0, then the entire snapshot buffer will hold samples
that came after the trigger event.

• If Pre-Trigger = Capacity, then the buffer holds samples that came
before the trigger event.

Limits: 0 ≤ Pre-Trigger ≤ Capacity ≤ Snapshot Maximum

If allowed, this setting determines how much pre-trigger data to include.
The value must be less than or equal to (≤) the selected capacity. 

• If a larger value is selected, an error message appears in the dialog
and the Save button is disabled. 

• The maximum value is <Text>.
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5.2.1.3 Set Mode

Select the Mode or combination of Modes from the options in Table 5-8:  

5.2.1.3.1 Continuous Mode Setting

If the check box for Continuous Mode is selected, the meter continues to
fill the buffer (and discard the oldest samples) until you press the Stop but-
ton.

If Continuous Mode is NOT selected, the meter collects samples until the
buffer is full and then automatically stops data collection. Press the Start
button to again fill the buffer with new samples. 

When running in non-Continuous Mode, press Stop to stop the buffer be-
fore it is full.

5.2.1.3.2 Wait Trigger Mode Setting

If the check box for Wait Trigger Mode is selected, the meter discards
sample data until the first trigger event is detected.

Starting with the first trigger event, the meter continues to fill the buffer
normally.

When the capture buffer is full, data acquisition stops or continues de-
pending on the setting for Continuous Mode. If Continuous Mode is select-
ed, the samples immediately that follow, the trigger may eventually be
overwritten.

Table 5-8.  Data Acquisition Modes

Mode Description

Continuous Mode Acquires data continuously until you press the Stop 
button. 

Wait Trigger Mode Discards sample data until first trigger event is detected. 
• Starting with that trigger, the meter continues to fill the buffer

normally.
• When the capture buffer is full, data acquisition stops.

Snapshot Mode Enables or disables Snapshot Mode. 
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5.2.1.3.3 Snapshot Mode Setting

Snapshot Mode is a special high-speed data acquisition mode that stores
data in the hardware SRAM of the instrument. Results must be uploaded
to the PC after all the data has been acquired.

Snapshot Mode captures High-Speed events at, for example, 625 kHz or
1 µSec per sample (the capture rate to the internal buffer inside the me-
ter). For specific values refer to the respective user manual for the meter
being used.

Snapshot Mode is only allowed if the current sensor supports high-speed
power mode. 

Clicking the check box for Snapshot Mode launches a dialog box, shown
in Figure 5-17. Highlights in the Snapshot Mode dialog box show edits
needed to enable Snapshot Mode. 

Figure 5-17.  Data Buffer – Snapshot Mode Settings Conflict
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5.2.2 For more information about how to use this feature, see ’Take a Snapshot 
Measurement’ (p. 153).Preview Buffer Settings

In the Preview Buffer Settings section of the Data Buffer tab, select the
samples and refresh period, shown in Table 5-9:  

Enter either: 

• An absolute number of samples.

• An equivalent duration in microseconds.

NOTICE 
If the user interface becomes sluggish or unresponsive, either lower
the Sample count or increase the Update period to reduce or eliminate
the issue.

5.2.2.1 Sample Count

Sample Counts control how many samples are used to update the pre-
view display. If you make this number too large, it can negatively affect the
application’s performance. The maximum value is 3000.

Capacity and Pre-Trigger settings in Snapshot Mode may be specified as
sample counts. This is the whole number of data samples contained in the
Snapshot buffer or in the Pre-Trigger portion thereof.

Sample counts may range from 0 to 240000, with the further restrictions
that Snapshot Capacity cannot be zero, and that pre-trigger capacity must
≤ the overall capacity.

Table 5-9.  Preview Buffer Settings

Option Description

Sample Count Specifies the number of preview samples used by the 
Preview buffer. The maximum value is 3000.

Update Period Specifies the refresh period, in seconds, that the Preview 
buffer uses to extract the most recent capacity samples. 
The fewer the seconds, the faster the update.
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5.2.2.2 Update Period (Preview Buffer)

The application maintains a separate buffer for displaying data acquisition
progress. The Data Buffer collects all the acquisition data.

However, for performance reasons, a separate Preview Buffer is used to
refresh the user interface periodically with just a subset of the most recent
data. The Preview Buffer is only used for High-Speed data acquisition.

The Update Period determines how often the Preview Buffer is updated
for display during high-speed data collection. If you make the number too
small, it can negatively impact system performance. The minimum value is
0.20.

5.3 Measurement Tab

The Measurement tab in the tool bar ribbon is shown in Figure 5-18: 

The Measurement toolbar includes areas to set:

• Corrections (Wavelength | Area)

• Options for measurement (Speed-up | Gain | Smoothing | Decimation)

• Window size (for high-speed energy measurement)

5.3.1 Measurement Corrections

In the Corrections area on the Measurement tab, you can set the Wave-
length and Area to be measured, as shown in Table 5-10:  

Figure 5-18.  Measurement Tab
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5.3.1.1 Edit Wavelength Table

To display available settings for the Wavelength, click the drop-down
menu. 

To edit the Wavelengths, right-click on the drop-down arrow of the Wave-
length menu to display the dialog box shown in Figure 5-19:  

Select Edit Wavelength Table to display a dialog box, shown in
Figure 5-20, where you can add or remove a wavelength that you previ-
ously added.  

Set or change a user-added wavelength as follows:

• Add a wavelength

• Remove a user-added wavelength

• Edit a wavelength

• Disable a wavelength

Table 5-10.  Measurement Tab — Wavelength and Area

Option Description

Wavelength Displays the current wavelength.

Area Specifies the area of the laser beam (either the beam area in 
cm2 or the beam diameter in cm). The formula for calculating 
area from diameter is p * (diameter / 2)2.

Figure 5-19.  Measurement Tab –Wavelength Drop-Down Menu
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Each of these are shown in the subsections that follow.

5.3.1.1.1 Add a Wavelength

To add a wavelength to the list, use one of the methods that follow:

• Directly type a new wavelength in the Wavelength field in the
Measurements tab toolbar.

• Edit the Wavelength Table to add the new wavelength. 

To add a new wavelength to the Wavelength Table:

1. Right-click the Wavelength drop-down menu in the Measurements tab
toolbar.

2. From the pop-up menu, select Edit Wavelength From Table.

3. At the bottom of the Edit Wavelength Table dialog box, enter a new
wavelength in the empty field to the left of the Add button.

4. Click Add. This saves the new wavelength to the table, and displays
the wavelength in the Wavelength drop-down menu in the toolbar.

5. Click Close.

Figure 5-20.  Edit Wavelength Table
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5.3.1.1.2 Remove a Wavelength

If the source of a wavelengths is identified by the sensor, that wavelength
cannot be removed from the Wavelength drop-down menu or the Wave-
length Table.

To remove a user-added wavelength from the drop-down list in the 
toolbar:

1. Select the wavelength from the Wavelength drop-down menu in the
Measurements tab toolbar.

2. Right-click the down arrow next to the user-added wavelength.

3. From the pop-up menu, select Remove Current Wavelength From
Table.

5.3.1.1.3 Edit a Wavelength

Editing the Wavelength Table removes a wavelength previously added by
a user.

To edit the Wavelength Table:

1. Select the wavelength from the Wavelength drop-down menu in the
Measurements tab toolbar.

2. Right-click the down arrow next to the user-added wavelength.

3. From the pop-up menu, select Edit Wavelength From Table.

4. In the Edit Wavelength Table dialog box, select the wavelength.

5. Click Remove.

6. Click Close.

5.3.1.1.4 Disable Wavelength Compensation

There is no way to disable wavelength compensation.

In the drop-down menu shown in Figure 5-21, [Specify wavelength] is
displayed only when a meter encounters a new sensor for the first time.
That simply means that a wavelength has never been selected for that
meter.

Remember to set the appropriate wavelength. If you attempt to run the
meter without doing so, a warning message is displayed as shown in
Figure 5-22: 
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After you set a wavelength, the setting is retained indefinitely and the
warning messages are no longer displayed. Users can change the wave-
length to other valid values but cannot disable it.

5.3.1.2 Area Correction

Area correction determines whether the Area Correction Value is specified
in terms of its actual area (in cm2) or the circular Diameter (in cm) of the
beam. Changing the dimension affects the range of valid correction val-
ues.

Figure 5-21.  Disable Wavelength Compensation

Figure 5-22.  Warning to Set a Wavelength
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To make a correction to the Area:

1. Under the Measurement tab, click the check box for Area to enable or
disable Area Correction.

2. Enter a value to be applied for Area Correction.

3. From the drop-down menu, select either Area (cm2) or Diameter (cm).

Either specification ultimately results in an underlying area value (in cm2).

• The minimum value for the correction value is 0.01 cm2 or around
0.113 cm.

• The maximum value is 500 cm2or around 25.23 cm.

The resulting area value is divided into the power or energy measure-
ments, resulting in Watts or Joules per cm2, as shown in Figure 5-23:  

5.3.2 Measurement Options

The options listed in Table 5-11 are available under the Measurement tab:  

Figure 5-23.  Measurement Tab – Area Correction

Table 5-11.  Measurement Options

Option Description

Speed-up Speeds up the rise time of a thermopile.
NOTE: Use this function only with thermopile sensors.

Smoothing Enables or disables Data Smoothing.
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5.3.2.1 Speed-up

When using thermopile sensors, some measurements rely on waiting for a
laser pulse to reach a peak value, which can take a very long time.

Speed-up calculates where the peak occurs, based on an extrapolation of
the first part of a measurement curve (based on an initial subset of sam-
ples). Speed-up uses this optimization to more quickly produce a mea-
surement.

5.3.2.2 Smoothing

Smoothing applies a ‘noise-reducing’ filter to the data samples collected in
the meter. This is a 32-sample bin average to reduce the “jitter” of the
measurements.

5.3.2.3 Gain

Gain applies an arbitrary gain factor to all measurements. For example, if
your sensor is downstream from a splitter or some other device that atten-
uates the actual laser beam, you can artificially inflate the measurements
so that they reflect the actual output of the laser, rather than what the sen-
sor measures.

• The gain factor must satisfy 0.001 ≤ gain factor ≤ 100000 (1e5).

• A gain factor of 1.0 is the same as disabling the option.

Gain Enables or disables the Gain factor and applies a factor to a 
meter reading. Gain may be any value > 0.
In particular, gain may make the measured result larger 
(value > 1) or smaller (1 > value > 0). This feature can be useful 
when measuring a source through a beam splitter or attenuator, 
or when applying a secondary calibration factor.

Decimation Slows down the data captured by the meter. For example, a 
decimation value of 2 causes the meter to discard every other 
sample (which is a 50% reduction in the data rate).

Table 5-11.  Measurement Options (continued)

Option Description
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5.3.2.4 Decimation

Controls the rate of decimation. If enabled, Decimation lowers the data
rate from the meter to the PC by discarding samples.

5.3.3 High-Speed Energy Measurement

The actual data transmission rate is the base sample rate divided by this
Decimation Rate. For example, a decimation value of “2” tells the meter to
discard every other sample (a 50% reduction in data rate). “3” means the
meter sends only every third sample, and so on. A value of 1 is the same
as disabling decimation.This setting applies only to energy measurements
on the high-speed channel using a PowerMax-Pro sensors only.

The Window Size specifies the window size (in µSec) for High-Speed
Joules energy measurements. The input value is expressed in microsec-
onds. The Valid Range is from 100 to 1,000,000 µSec. 

The window size determines which of two different algorithms are used for
energy measurements, as follows:

• 10 µSec setting: Selects a peak detection algorithm. The energy
calculation is based on the Peak Power of the pulse that is found in
this (smallest possible) detection window. In this case, the energy
calculation is independent of the actual pulse width.

• 100 through 1000000 µSec: Range of settings selects an integration
algorithm.

The energy calculation is obtained by integrating the power values, start-
ing with the trigger event, and that follow through for the full duration of the
window. In this case, the energy calculation is entirely dependent on the
window size.

For optimal energy measurements, size the window slightly smaller than
the nominal pulse rate for the input signal. 

• If the window is too small, energy measurements can be understated.

• A window that is too large can exaggerate the energy measurement.

5.4 Trigger Tab

The Trigger tab in the tool bar ribbon is shown in Figure 5-24: 

The Trigger tab includes the sections that follow:

• Trigger Level (Watts | Percent)
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• Trigger Settings (Source | Edge | Delay)

• Long Pulse Energy Mode (Trigger Level)

Use settings on the Trigger tab to configure the meter to detect trigger
events.

Trigger events are marked with a vertical red line in the Trending display. 

For an example about how to use Triggers in Snapshot Mode, see ’Take a
Snapshot Measurement’ (p. 153).

5.4.1 Trigger Level

The Trigger Level specifies a way to calculate the energy of a pulse from a
power measurement.

Any trigger setting between the data minimum and maximums causes a
trigger. If you do not know the Peak Power, enter a Level setting between
zero and the average power. 

Table 5-12 shows the settings that you can specify:  

Figure 5-24.  Trigger Tab

Table 5-12.  Set Trigger Levels

Option Description

Watts or 
Joules

Specifies the trigger level as an absolute measurement in the 
current measurement unit (Watts or Joules). 

Percent Specifies the trigger level as a percentage of maximum Joules or 
Power rating of a probe.
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5.4.1.1 Trigger Unit

Enter a setting in Watts that represents a level approximately 50% be-
tween zero and the Peak Power you expect each pulse to have. Valid
Trigger Level Values range from Minimum to Maximum. Changing the
Trigger Level Value setting automatically makes the appropriate adjust-
ment to the Trigger Level Percent setting.

5.4.1.2 Notation

To select either a Scientific Notation or Fixed Notation format, right-click
on the word Watts. In the pop-up dialog box, select the desired format, as
shown in Figure 5-25. When selected, the Trigger Level value is displayed
in Scientific notation; otherwise, the Trigger Level value is in Decimal nota-
tion.  

5.4.1.3 Trigger Level Percent

Specifies the Trigger Level as a percentage of full range in the current
measurement range. Changing the Trigger Level Percent setting automat-
ically makes the appropriate adjustment to the Trigger Level Value setting.

Valid Trigger Level Percent values range from Minimum to Maximum. For
Pyroelectric probes, the valid range is 0.0001 to 30%.

• When using a PowerMax-Pro probe in Watts mode, the valid range is
0 to 100%.

• When using a PowerMax-Pro probe in Joules mode, the valid range
is 0.0001 to 100%.

Figure 5-25.  Trigger Tab – Notation (Scientific or Fixed)
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5.4.2 Trigger Settings

Trigger events occur when the meter detects a series of measurements
that cross a trigger level but do so only in a specific direction (either rising
or falling), as shown in Table 5-13:  

5.4.3 Long Pulse Energy Mode

Long Pulse Energy Mode is a special measurement mode that looks for
pulses and calculates the energy of pulses (measured in Joules).

This mode is used for legacy PowerMax USB/RS (“Meterless”) Sensors
(that is, a sensor other than PowerMax-Pro USB/RS). The threshold set-
ting is enabled only for those legacy products and is disabled in all others. 

For information about how to take an Energy Measurement, see p. 160.

NOTICE
When Long Pulse Energy Mode is set, all other trigger controls are not
used.

Table 5-13.  Trigger Settings—Rise and Fall

Option Description

Source Select the trigger source based on:

Internal An internal analysis of the measurement data itself by the 
meter.

External An external electrical input through the trigger input 
connector.

Edge Selects the trigger edge (external triggering only).

Positive aka Rising Edge: Triggers when a sequence of measure-
ments below the trigger level, are followed by a measure-
ment that is above the trigger level.

Negative aka Falling Edge – Triggers when a sequence of 
measurements above the trigger level, are followed by a 
measurement that is below the trigger level.

Delay Instructs the meter to delay data capture until after a certain amount of 
time (a specified number of microseconds) that follow a trigger event. 
Delay is meaningful only for External Triggers.
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To start Long Pulse Energy Mode when using a legacy sensor:

1. In the Coherent Meter Connection software, go to the Home tab in the
Operating Mode section. From the Mode drop-down menu, select
Energy (Joules).

2. Under the Trigger tab in the Long Pulse Energy Mode section, select
the Trigger Level (Low, Medium, High) from the drop-down menu.

3. In the Trending tab window, right-click and, from the Source pop-up
menu, select ‘Show Trigger Markers’.

NOTE: The trigger level is computed dynamically from the actual
sensor data, so the selections you choose are relative (Low, Medium,
High) and not absolute. Experiment until you find the best setting for
your particular needs.

5.5 View Tab

Figure 5-26 shows the View tab on the tool bar. The View tab controls the
display of the user interface. 

The View tab includes the sections that follow:

• Visible Panels (Measurements | Graphics | Statistics)

• Visible Windows (System Information | I/O Transcript | Error
Messages)

• Output Formats (Resolution | Analog Out | Measurements)

• Polling (Continuous Update | Meter Polling)

• Data Capture (Stop on Missing Samples | Retain Binary Data |
Upload IDs)

Figure 5-26.  View Tab
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5.5.1 Visible Panels

The  items that follow, in the Visible Panels section control which panels
that are displayed in the lower half of the user interface. These can also
be selected in the drop-down menu.

• Measurements 

• Graphics

• Statistics

All selections are enabled by default. 

• At least one panel must be displayed.

• You can display one, two, or three panels at the same time.

• You can hide one or two panels at the same time.

If you do not want to display any of those panels, click the check box to
deselect that panel.

5.5.2 Visible Windows

The Visible Windows section displays the options that follow, shown in
Table 5-14: 

5.5.2.1 System Information

When you click the check box for System Information under the View Tab,
or select from the main drop-down menu select View > Show System In-
fo, the dialog box shown in Figure 5-27 displays: 

Use the scroll bars to display all information. Also click the down-arrow
next to ‘Meter Properties’ to expand or contract information shown in
Figure 5-28, for all categories included in this window:

Table 5-14.  View Tab — Visible Windows

Option Description

System Information Displays a summary of meter and sensor settings.

I/O Transcript Displays a transcript of communication between the 
user interface and the meter. This transcript does not 
include binary or High-Speed data.

Error Messages Reports errors detected by the system.
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• Meter Properties

• Sensor Properties

• Persistent Settings

• Other Settings — This includes the Installation Date for
Licensed features, as well as a list of remaining days for the
Free Trial.

To display a context menu, shown in Figure 5-28, right-click in the dialog
box and save or copy details:  

Figure 5-27.  View Tab – System Information
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5.5.2.2 I/O Transcript

When you click the check box for I/O Transcript under the View Tab, or se-
lect from the main drop-down menu select View > Show IO Transcript, the
dialog box shown in Figure 5-27 is displayed: 

The I/O Transcript window displays a transcript of communication be-
tween the user interface and the Meter hardware.

This includes all communications from when the meter was first opened,
regardless of when the Transcript window was opened. This transcript
only includes text commands to and responses from the meter, and spe-
cifically excludes any binary or high-speed traffic.

Right click in the window to display a context Menu, shown in Figure 5-30.
Select any of the options on the menu as desired.  

Figure 5-28.  View Tab – System Information Context Menu
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5.5.2.3 Error Messages

When you click the check box for Error Messages under the View Tab, or
select from the main drop-down menu select View > Show Error Log, the
dialog box shown in Figure 5-27 is displayed:  

For more information, see the section ’Stop On Missing Samples’ (p. 75).

Figure 5-29.  View Tab – I/O Transcript

Figure 5-30.  View Tab – I/O Transcript Context Menu
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5.5.3 Output Formats

Table 5-15 shows the options available for output formats:  

Each of these options are shown in the subs-sections that follow.

5.5.3.1 Resolution Value

The Resolution value determines the total number of real numbers dis-
played (3, 4, or 5 digits). This is NOT the number of digits to the right of
the decimal point.

Figure 5-31.  View Tab – Error Messages

Table 5-15.  View Tab — Output Formats

Option Description

Resolution Selects the Resolution value. Number Resolution controls the 
formatting of all measurement values.

Analog Out Selects the full-scale voltage (1, 2, or 4 volts).

Measurements Selects the source of the data shown in the main Measure-
ment Panel and includes measurement values in the data 
stream.
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The display of measurement values is further affected by the current
Range setting. For example, a 300 mW range with 4 digits selected shows
numbers such as 102.4, 33.89, or 1.302.

5.5.3.2 Analog Out

The front panel of the LabMax-Pro SSIM meter has a connector labeled
Analog Out. The hardware outputs an electrical voltage that is proportional
to the measurements being read by the meter. Analog output is only active
when the meter is running.

The signal is not available for Pyro sensors or PowerMax-Pro sensors in
Snapshot mode.

NOTICE
The Combo Box is always enabled, and any changes take effect the
next time Analog Out becomes active.

Select the output voltage (1, 2, or 4 volts) from the Analog Out drop-down
menu that corresponds to a full-scale measurement, as shown in
Figure 5-32: 

5.5.3.3 Measurements

All choices are updated regularly when the meter is running; when the me-
ter is stopped, only Live readings update.

The type of measurement is also displayed in square brackets that follow
the selected operating mode. Table 5-16 shows the types, which include: 

Figure 5-32.  View Tab – Analog Out
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5.5.4 Polling

Table 5-17 shows the options available for polling:  

5.5.4.1 Continuous Update

Continuous Update gives a continuous, general view of what the sensor
sees when the meter is not running. Selecting this feature refreshes the
main Measurement panel periodically whenever the meter is stopped.
This feature requests measurement readings and updates that follow:

• The upper Measurements panel, the Tuning tab, and Sensor
temperature readings (if supported). Temperature is functional
only when there is no active measurement.

• Certain error conditions also are tested for and reported.

The Acquisition Buffer, Trending tab, Histogram, Statistics, and other dis-
plays all are not updated.

Updating is automatically replaced by the Preview mechanism when you
Start data acquisition.

Table 5-16.  Output Format Measurement Types

Option Description

Mean The arithmetic mean of all samples.

Minimum The smallest sample.

Maximum The largest sample. Maximum values are not enforced.

Live The most recent sample from the instrument.

Filtered A simple filter applied to the most recent 32 samples.

Table 5-17.  View Tab — Polling Options

Option Description

Continuous Update Enables or disables Continuous Update mode. This 
feature is only activate if Meter Polling is also enabled. 

Meter Polling Enable or Disable Meter Polling Mode. When en-
abled, the application periodically queries the meter
for status. 
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5.5.4.2 Meter Polling 

Meter Polling checks the meter status (sensor connects, sensor discon-
nects, and meter shutdowns).

• The primary purpose of polling is to detect sensors (and the meter
itself) as they are connected or disconnected.

• Secondarily, polling is necessary to support Continuous Update
mode.

5.5.5 Data Options

Table 5-18 shows the Data options available in the View Tab:  

5.5.5.1 Stop On Missing Samples

The check box to Stop On Missing Samples controls how the software
handles Missing Samples errors.

• If checked, the meter stops data acquisition and displays an
error dialog.

• If unchecked, the meter continues collecting data despite the
errors.

In either case, the data buffer flags will mark the samples that follow the
missing ones and the Measurements panel displays a red Missing indica-
tor.

Table 5-18.  View Tab — Data Options

Option Description

Stop On Missing 
Samples

Controls how the software handles Missing Samples 
errors. 

Retain Binary Data Instructs the meter to save the binary bytes along 
with each data record. 

Upload Sequence IDs Includes Sequence ID values in the data stream.
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5.5.5.2 Retain Binary Data

The check box to Retain Binary Data instructs the meter to save the binary
bytes along with each data record.

Selecting this feature takes more space, and also displays a hex version
of the binary data in exported files. This feature is primarily used to debug
Meter communications.

5.5.5.3 Upload Sequence IDs

The meter assigns timestamps to each data sample, based on an internal
timer. Selecting this check box to Upload Sequence IDs causes the meter
to upload timestamps so they are included in exported data files.

Using timestamps imposes additional overhead for data communications,
and otherwise not used by the software. This feature is primarily used to
debug Meter communications.
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6 User Interface – Panels

This section shows the areas in which you can view data in various panels
of the Coherent Meter Connection software: 

• Measurements Panel in the middle of the window (p. 77)

• Graphical view panels in the lower half of the window, using these
tabs:

• ’When the sensor is inactive, sensor readings are not available.’
(p. 81)

• ’Trending Window’ (p. 86)

• ’Histogram Panel’ (p. 118)

• ’Beam Position Panel’ (p. 121)

• ’Diagnostics Panel’ (p. 122)

Each of these viewing areas are shown in the sections that follow.

• For information about Statistics gathered that can be used for refer-
ence or data analysis, see ’Statistics and Pulse Analysis’ (p. 125)

• For information about how to take Power or Energy measurements
using the Coherent Meter Connection software, see ’Measurement
Modes’ (p. 141).

6.1 Measurements Graphics Panel

The Measurements Graphics Panel is the display area between the tool
bar ribbon and the tabbed windows. This area displays data as it is being
collected. 
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On start-up, the window does not contain any measurements but instead
instructs users to open a meter, as shown in Figure 6-1:  

After you open a meter, the display changes to reflect the settings you se-
lected. Figure 6-2 shows an example of numbers displayed in the panel if
you selected measurements to be done in Power/Watts:  

Figure 6-1.  Measurements Panel On Start-Up

Figure 6-2.  Measurements – Display in Power/Watts
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Figure 6-3 shows an example of numbers displayed in the panel if you se-
lected measurements to be done in Energy/Joules:  

6.1.1 Exceptional Condition Indicators

Indicators in the top right corner of the Measurements Panel are displayed
only when they are triggered by a specific condition, as shown in
Figure 6-4: 

These indicators are shown in Table 6-1:  

Figure 6-3.  Measurements – Display in Energy/Joules

Figure 6-4.  Measurements — Triggered Condition Indicator
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6.1.2 Temperature Conditions

The sensor temperature is updated about every 10 seconds. Temperature
readings are not updated while data acquisition is in progress.

The temperature reading is at the bottom of the window (lower right cor-
ner), shown in Figure 6-5: 

When the sensor is taking an active measurement, the temp field is gray
and is not actively polling for information updates. 

When the measurement or sensor is idle, then the temperature is actively
being updated.

Table 6-1.  Condition Indicators in Measurements Panel

Icon Description 

The sensor indicates an over-temperature condition. Set the laser to  
and allow the sensor time to cool.

Displayed when the input signal is ≥ 90% of full scale. Any samples 
in excess of 100% full scale are truncated to the 100% level.
• If in a fixed range, select a higher range.
• If in AUTO or the highest range available, change the configuration 

to use a lower laser power level.

To improve the measurement precision, set to a lower fixed range.

Missing sample indicator. Displays when the meter reports that the 
workstation was unable to upload all the sample data before a buffer 
internal to the meter overflows. 
Depending on the option selected in the menu for Stop On Missing 
Samples, the meter either stops and displays a dialog or continues 
to collect data despite the error.

Figure 6-5.  Measurements – Display Temperature
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Displays for temperature conditions include:

• When the sensor displays no symbol, the temperature is normal.

• When the sensor is taking an active measurement, the tempera-
ture field is gray and is not actively polling for information
updates.

• When the measurement or sensor is idle, then the temperature
is actively being updated.

• When the sensor is enabled, the temperature is updated approxi-
mately every 10 seconds.

• When the sensor is disabled, readings are not updated while data
acquisition is in progress.

6.2 Tuning Panel

When the sensor is inactive, sensor readings are not available.

The Tuning tab displays the current reading in either the Needle Dial view
or the Bar Graph view, as shown in Figure 6-6. The recent minimum and
maximum values are also displayed on either side of the window.  

Capture the image in the Tuning panel and save it to a file on the worksta-
tion, as follows:

1. Right-click in the window and then select Save Tuning Image to a
File...

2. In the standard Windows dialog box, browse to the directory needed
to save the file.

Change the display in this panel using the controls shown in the subsec-
tions that follow.
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6.2.1 Reset Min/Max

To reset the Minimum and Maximum values, click the Reset Min/Max but-
ton, shown in Figure 6-7: 

To clear the Minimum and Maximum values and again start tracking the
values, beginning with the most recent value. 

NOTICE
The Minimum and Maximum values are local to the tuning dials and
have no correlation to the numbers displayed in the Statistics panel.

Figure 6-6.  Tuning Panel

Figure 6-7.  Tuning – Reset Minimum/Maximum Values



User Interface – Panels 

83

6.2.2 Display View

To change the style of the image in the Tuning panel:

1. From the drop-down menu next to Range in the Tuning window, select
the style (either a Bar Graph or the Needle Dial), as shown in
Figure 6-8. This changes the style in which you want measurements
displayed in this panel.

2. To change that, simply select the other option from the drop-down
menu.

Selecting Bar Graph displays in view as shown in Figure 6-9: 

6.2.3 Tuning Range

Use the Tuning Range dialog box to scale measurement dimensions.

Figure 6-8.  Tuning – Change Display View

Figure 6-9.  Tuning – Bar Graph Display
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1. Open by clicking the down arrow next to Range in the Tining window.
The Tuning Range dialog box is displayed, as shown in Figure 6-10: 

2. To select the Maximum setting, click the drop-down menu.

3. To select the Minimum setting, click the drop-down menu.

4. To reset the dialog box, click Restore Defaults. This resets the dial to
Auto for scaling. The range is set to a simple default, but then
expands automatically to accommodate any values encountered.

5. Close the Tuning Range dialog box by clicking the x in the top-right
corner of the Tuning Range menu.

6.2.4 Save Tuning Image

You can also save the image from the Tuning window to a file. To do so,
do the following:

Figure 6-10.  Tuning – Options for Tuning Range
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1. Right-click in the Tuning window. The command shown in Figure 6-11
is displayed:

2. The command opens the standard Windows browser. Select a direc-
tory where you want to store the image file, and click Save.

Figure 6-11.  Tuning Tab—Save Tuning Image
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6.3 Trending Window

The display in the window for the Trending tab shows an X-Y chart of cur-
rent data, as shown in Figure 6-12:  

When taking a measurement with a pyroelectric sensor, the horizontal axis
values at the bottom of the Trending window are displayed in terms of
Pulse ID (rather than Elapsed Seconds).

Use these methods to navigate in the Trending window to view the entire
data set:

• Drag either handle on the Navigation Bar to zoom in or out on
the displayed data.

• Drag the Navigation Bar right or left to shift the display forward
or backward in time.

• Double-click the Navigation Bar at the bottom of the Trending
window to expand the display to 100% of available data.

A vertical Navigation Bar is shown whenever less than 100% of the height
of the displayed data is visible. You can also zoom inside the window; see
’Zoom Mode’ (p. 95).

Figure 6-12.  Trending Window
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6.3.1 Trending Chart Context Menu

Right-click in the Trending window to display the context menu, shown in
Figure 6-13:  

Selections in this pop-up menu are shown in Table 6-2. More information
about each these commands are provided in the sections that follow. 

Figure 6-13.  Trending – Context Menu

Table 6-2.  Trending Window – Context Menu Descriptions

Menu Option Description

Show Selection 
Bounds Cursors

Displays cursors as vertical lines (sample time positions) and horizontal lines 
(measurement levels) in the Trending window. See p. 88 for details.

Snap to Triggers Aligns the vertical cursors with existing trigger events on the horizontal axis 
in the Capture buffer (see p. 89). 

Show Trigger 
Markers

When the Show Trigger Markers dialog box is checked, Trigger events 
become visible in the Trending display (see p. 90).

Highlight Sample 
Points

An annotation that shows a small circle for each sample (see p. 90).

Show Tracking 
Cursor

Displays a pair of vertical and horizontal dashed lines that represent time 
and measurement (see p. 91). Inspect captured data, a single sample at a 
time.



Coherent Meter Connection User Manual

88

NOTICE
When features are not enabled, they are shown in gray and have no
operation. This is because the feature is not applicable to a particular
sensor.

6.3.1.1 Show Selection Bounds Cursors

Selection Bounds Cursors set the area for measurement data, as follows:

• Vertical lines represent sample time positions.

• Horizontal lines represent measurement levels.

Pulse Analysis 
Enabled

Toggle to enable or disable Pulse Analysis (see p. 92). 

Export Pulse Anal-
ysis Results

Saves Pulse Analysis information to an external file (see p. 93).

Pulse Analysis 
Settings

Displays the Pulse Analysis dialog box where you select settings in a series 
of tabs (see p. 99).

Cursors… Allows users to select a range of data in the Trending window (see p. 91).

Zoom Mode View a portion of the available data (see p. 95 for Zoom options).

Export Buffer Data 
to File

Saves collected data to a file in the format specified (.csv, .tsv. or .txt); see 
p. 98.

Save Trend Image 
to File

Saves a graphic image to a file (see p. 98). Specify the format for the file 
as .bmp, .gif, .jpg, or .png. 

Table 6-2.  Trending Window – Context Menu Descriptions (continued)

Menu Option Description
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The Show Selection Bounds Cursors option displays Cursors on the
Trending chart, as shown in the example in Figure 6-14.  

Selection Bounds Cursors are displayed as red dashed lines. There are
four selection boundaries: left, right, upper, and lower. 

The area ‘under the curve’ is highlighted in blue. This corresponds to the
calculation of energy of the range of samples between the left and right
cursor.

Move these cursors using the mouse in the same way you move the edge
of a window to resize it.

In the Statistics Panel to the right of the Trending window, the Selection
Bounds statistics are updated to reflect the values for the Selection
Bounds.

6.3.1.2 Snap To Triggers

Aligns Vertical cursors with existing trigger events on the horizontal axis in
the Capture buffer. 

• When enabled, Snap To Triggers mode constrains Vertical cursors to
align with the closest existing trigger event on the horizontal axis in
the capture buffer. Only Vertical cursors are affected. When moving
Vertical cursors, they ‘jump’ to each successive trigger location.

Figure 6-14.  Show Selection Bounds Cursors
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• When disabled, cursors may be moved freely to any location. Cursors
remain wherever they happen to be at the time.

6.3.1.3 Show Trigger Markers

Trigger events become visible in the Trending display when the Show
Trigger Markers selection is checked.

• Vertical red lines indicate the location of trigger events.

• A horizontal green line indicates the trigger threshold level.

To most system performance, the number of trigger events shown are lim-
ited to the first 20 while measurements are being taken (Preview mode) or
the first 2000 trigger events after measurements have been taken.

The visual trigger markers are important to confirm that good triggers are
occurring before entering and gathering data in Snapshot mode.

After confirmation that triggering is good for a particular set-up, system
performance can be increased by set check box for trigger markers to off.

6.3.1.4 Highlight Sample Points

A Sample Point is an annotation that simply shows a small circle for each
sample. Because a small point would be difficult to see on a normal chart
in the Trending window, the software instead draws a small circle at each
sample’s location. This enhances visibility for the data displayed.
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To show or hide this feature, right-click the context menu in the Trending
panel and toggle the feature on or off. Selecting the Highlight Sample
Points option displays the circles in the Trending chart, as shown in the
example in Figure 6-15.  

NOTICE
When using High-Speed data, it is recommended that to set the High-
light Sample Points feature to OFF.

After Start is pressed, wait for the first energy sample. The application pro-
cesses the samples in the background for approximately one second of
CPU time before displaying the annotated region of the buffer on the left
side of the Trending window. The chart displays only after several samples
are taken. 

6.3.1.5 Show Tracking Cursor

The Tracking Cursor is used to examine the precise position of individual
measurement samples. The window shows the current position (time) and
value of the measurement.

Select different samples by dragging the vertical line to the left or to the
right.

Figure 6-15.  Trending – Highlight Sample Points
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Enable or disable the Tracking Cursor in the context menu by right-clicking
in the Trending window, and then selecting (or deselecting) Show Tracking
Cursor.

When you select Show Tracking Cursor, both a vertical line as well as an
information box is displayed in the Trending window, as shown in
Figure 6-16:  

The positions of the Tracking Cursors determine the Selection Bounds,
which in turn affects the calculation of Selection Statistics.

When enabled, the Trending window displays a pair each of vertical and
horizontal dashed lines, called Cursors. 

• Vertical lines represent Time Cursors that mark sample time positions
on the horizontal axis of the Trend chart.

• Horizontal lines represent Measurement Cursors that mark measure-
ment levels on the vertical axis of the Trend chart.

Move Cursors by dragging the vertical drag line with the mouse. This al-
lows you to inspect captured data a single sample at a time. 

Also see ’Cursors…’ (p. 94) for information and examples about managing
cursors. 

6.3.1.6 Pulse Analysis Enabled

The menu option enables or disables Pulse Analysis. This feature must be
enabled before you can view any analysis results. At the bottom of any
tab, click check box to enable or disable Pulse Analysis.

Pulse Analysis may only be performed on Power measurements and is
disabled for Energy data, for Pyro sensors, and whenever the capture buf-
fer contains no data.

Figure 6-16.  Trending – Show Tracking Cursor
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Visibility of annotations in the Trend window depends on other settings in
the Display Options tab. Enabling Pulse Analysis also requires Enabling
the Selection Cursors, which is done automatically when you turn on
Pulse Analysis. Pulse Analysis is confined to the region of the buffer delin-
eated by the Selection Bounds.

6.3.1.7 Export Pulse Analysis Results…

Use the menu option to Export Pulse Analysis Results… to extract and
save all data in the Acquisition Buffer to an external file. Selecting this
commands prompts users to specify a destination file name.

If no pulses are detected, the message shown in Figure 6-17 is displayed. 

6.3.1.8 Pulse Analysis Settings…

The menu option for Pulse Analysis Settings… displays the Analysis Op-
tions dialog box with four tabs. For details about the dialog box, see ’Anal-
ysis Options’ (p. 99).

Selections in this dialog box affect how Pulse Analysis inputs and outputs
are presented in the Trending window. At the bottom of any tab, click
check box to enable or disable Pulse Analysis.

Figure 6-17.  Trending – No Pulse Data to Export
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6.3.1.9 Cursors…

The menu option for Cursors… applies to the Selection Bounds Cursors.
Selecting Cursors… displays these options, shown in Figure 6-18:  

To enable or disable cursors:

1. Right-click in the Trending window.

2. From the pop-up menu, select Cursors. 

Options include:

• Reposition cursor

• Zero lower cursor

• Select entire buffer

3. Double-click the Navigation Bar to expand the display to 100% of
available data. 

Cursors do not move when you zoom in or out.

Cursor positions are saved after each measurement.

6.3.1.9.1 Reposition Cursors

The Reposition Cursors command generally makes all cursors visible.

Selecting the Reposition Cursors command moves the upper and lower
cursors to the maximum and minimum values in the buffer. This command
also sets the left and right cursors at the 1/3 and 2/3 positions in the win-
dow respectively.

When you exit and restart the software, cursors remain wherever you left
them. Because of this, some cursors are restored to positions that are not
visible on the screen. Use the Reposition Cursors command to view cur-
sors.

Some annotations (particularly Trigger markers and Sample Point High-
lights) are too expansive to render for all of large capture buffers. The soft-
ware draws only the left-most cursor and does not show other markers.

Figure 6-18.  Trending – Options for Cursors
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Therefore, if you turn on trigger markers and scrolled off to the right, you
may not see any cursors until you zoom out or scroll back to the left. Use
the Reposition Cursors command to again view cursors.

6.3.1.9.2 Zero Lower Cursor

The lower cursor is the moved to the 0W line.

6.3.1.9.3 Select Entire Buffer

This option lets users select the entire buffer, which is useful when sam-
ples may be outside of the display area.

6.3.1.10 Energy Baseline

The energy baseline tracks the lower bounds of the Selection Cursor. This
setting enables Energy calculations to be performed relative to a baseline
measurement, representing the lowest possible energy. For more informa-
tion about the Energy Baseline, see ’Energy Options’ (p. 107).

6.3.1.11 Zoom Mode

Zoom Mode allows you to change the magnification level of data dis-
played in the window to view a portion of the available data. Options in-
clude:

• Zoom Show All

• Zoom None

• Zoom Horizontal

• Zoom Vertical

• Zoom Both

To zoom:

1. Go to the Trending window and right-click to display the context
menu.

2. From the menu, select Zoom Mode…
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3. Choose one of the options shown in the pop-up menu, shown in
Figure 6-19.  

The examples that follow describe how to zoom in or out when viewing
measurements in the Trending chart.

Click and drag the mouse, then release to define a portion of the display.
The chart zooms in to display the selected section, as shown in
Figure 6-20.  

Figure 6-19.  Trending – Zoom Mode Menu Options

Figure 6-20.  Trending – Zoom Example 1
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Use the mouse wheel to zoom in or out, as shown in Figure 6-21.  

Use the scroll bar to define a portion of the display (drag either the left or
right handle in the scroll bar) or scroll the display (drag the scroll bar to the
left or right), as shown in Figure 6-22. 

Figure 6-21.  Trending – Zoom Example 2

Figure 6-22.  Trending – Zoom Example 3
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6.3.1.12 Export Buffer Data to File

The menu option to Export Buffer Data to File… is available only if the
Selection Cursors are active.

This command includes an option to export only that portion of the buffer
marked by the left and right Cursors. This is useful for extracting interest-
ing subsets of data from a capture buffer.

When you select Export Buffer Data to File…, the dialog box shown in
Figure 6-23 is displayed: 

6.3.1.13 Save Trend Image to File

The menu option to Save Trend Image to File… displays a standard Win-
dows dialog box, where users can browse to the location   to save the
trend image.

6.3.2 Trending Options

Directly under the Trending tab is a bar, shown in Figure 6-24, that pro-
vides information about measurements, as well as selections to display di-
alog boxes for Pulse Analysis and Scaling.  

Figure 6-23.  Trending – Export Data to File

Figure 6-24.  Trending – Information and Options Bar
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Click the drop-down menu for Analysis Options or Scaling to select set-
tings for those topics.

• Selecting Pulse Analysis Options from the drop-down menu in the
Trending window is different than selecting Pulse Analysis Statistics
to be displayed in the Statistics panel. Pulse Analysis can be done
only on captured data (in the buffer) when the meter is not running.

• Scaling

6.3.3 Analysis Options

Pulse Analysis is a feature that analyzes captured data from high-speed
PowerMax Pro sensors, detects pulse waveforms, and summarizes statis-
tics about each one.

NOTE: Pulse analysis is disabled for Energy data, for Pyroelectric
sensors, and whenever the capture buffer contains no data.

Pulse Analysis includes:

• Examining individual data samples in order

• Determining when pulses start and stop

• Calculating and recording the resulting statistics

The analysis applies to the data between selection Cursor positions. Us-
ers can select individual pulses, multiple pulses, or the entire buffer for
analysis.

When Pulse Analysis is enabled, the analysis computation is performed
automatically each time any setting is changed in the user interface and
each time data acquisition stops. The display in the Trending window is
automatically updated and reflects the current results.

The overall shape is in the form of a “rectangle”, formed by a rather rapid
“rise time” followed by a period where the signal stays more or less level,
and then a “fall time” period where it returns to the baseline. The signal is
“noisy” (displayed as jagged lines) before, during, and after the pulse.

Display and analysis options available in the Trending Chart window for
Pulse analysis settings are shown in more detail in the sections that fol-
low.

Pulse Analysis with PowerMax Pro sensors is not available when a stan-
dard LabMax Touch meter is used. 
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These functions require a LabMax Touch Pro meter:

• The drop-down menu for Analysis Options (shown in Figure 6-25):  

• The Pulse Analysis options in the window pop-up menu (shown in
Figure 6-26): 

Figure 6-25.  License Manager – Analysis Options

Figure 6-26.  Pulse Analysis Context Menu Options
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6.3.3.1 Enable Pulse Analysis

At the bottom of each tab in the Pulse Analysis Settings dialog box is the
area shown in Figure 6-27: 

This check box enables or disables Energy calculations. You must enable
Pulse Analysis to view any energy measurements or analysis results. En-
abling Energy Analysis is only meaningful if Pulse Analysis is enabled.

Pulse Analysis may only be performed on Power measurements and is
disabled for Energy data, for Pyroelectric sensors, and when the capture
buffer contains no data.

Visibility of annotations in the Trending window depend on the other set-
tings in the Display Options tab. Enabling Pulse Analysis necessitates
also Enabling the Selection Cursors, which is done automatically when
you turn on analysis.

The Export Results button allows you to export the Pulse Analysis results to
an external file.

Figure 6-27.  Trending – Enable Pulse Analysis
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6.3.3.2 Threshold Level

The Threshold Levels tab is shown in Figure 6-28. Use this tab to view
and change various threshold levels that affect pulse detection, as well as
Rise Time and Fall Time calculations.  

You can choose settings either by Percent value or Level value:

• Percent Value: Settings for this threshold level as percentage of the
Maximum. 

• Level Value: Settings for this threshold level as an absolute Measure-
ment value.

Troubleshooting tips:

• If you find that you are not capturing pulses, restore the default
settings. Settings can be changed using the menu above. 

• Settings can also be changed by moving the trigger lines in the
trending window. Sometimes these lines are moved when that was
not intended.

6.3.3.3 Analysis Threshold Level Settings

Analysis depends on threshold values, listed in Table 6-3. To enable Pulse
Analysis, click the check box at the bottom of the dialog box for Threshold
Levels.  

Figure 6-28.  Trending – Pulse Analysis – Threshold Levels Tab
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Thresholds are specified by the user either as an absolute power value or
as a percentage of the maximum. For a given maximum, the figures are
interchangeable.

The percentages define the levels relative to the baseline and the overall
maximum of the pulse. By default, thresholds are set at 10%, 50% and
90%. Percentages are more useful overall because they automatically ad-
just to different power levels. Changing power level changes the height of
the pulse, but the overall shape often remains much the same.

Thresholds may be easily changed—either drag the corresponding level
markers on the chart or, in the Analysis Options dialog box, define settings
on the Threshold Levels tab.

• The Upper Threshold must be as high as possible, but must be low
enough to include all pulses.

• The Lower Threshold must be set above zero, high enough to exclude
noise but low enough to capture the starting and ending points of all
pulses.

• There is an additional setting for Middle Threshold. The setting does
not play a direct role in analysis and is hidden by default in the Display
Options dialog box. The Middle Threshold is provided if you want to
measure Pulse Width in terms of the time between crossing the 50%
levels.

If the waveform is noisy, the Upper Threshold must be low enough and the
Lower Threshold must be high enough so that the noise does not detect
extraneous pulses.

If you have an issues capturing pulse information, it is recommended that
you reset the application to the factory default settings.

Table 6-3.  Pulse Analysis Threshold Levels

Option Description

Threshold The maximum value inside the selected field.

• Upper Threshold Used for Rise Time and Fall Time calculations.

• Middle Threshold Used to display the middle crossing location.

• Lower Threshold Used for rise time and fall time calculations.

• Energy Baseline Used for energy calculations.

Percent Threshold level as percentage of the Maximum.

Level Threshold level as an absolute measurement 
value.
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6.3.3.3.1 Thresholds Set Properly

The example in Figure 6-29 shows the Thresholds set properly. The Pulse
Analysis chart zooms in on the last of the four pulses.  

• The Start times are green lines, the Stop times are red lines.

• The left pair is the Rise time, the right pair is the Fall time. 

• Start and Stop times show the width of the Rise and Fall times for the
pulse.

Note that the Start and Stop times for each of the rising and falling edges
are close together. In this example, Statistics show 27.20 μSec and
75.20 μSec respectively.

Figure 6-29.  Threshold Levels Set Properly
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6.3.3.3.2 Upper Threshold Too High

If the Upper Threshold level is set too high, the Fall time is grossly distort-
ed. As shown in the example in Figure 6-30, the Fall time is distorted to al-
most half of the original pulse width (not desirable).  

If the Upper Threshold level is set way too high, the pulse is ignored, as in
Figure 6-31.  

Figure 6-30.  Upper Threshold Too High — Fall Time Distorted

Figure 6-31.  Upper Threshold Way Too High — Pulse Ignored 
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6.3.3.3.3 Lower Threshold Too Low

Similarly, if the lower level is too low, the pulse is not detected, as shown
in Figure 6-32.  

6.3.3.3.4 Popular Threshold Levels Combinations

The section in the lower half of the Threshold Levels dialog box allows you
to set all percentages according to a previously saved configuration.
Table 6-4 lists the options:

Figure 6-32.  Lower Threshold Too Low — Pulse Not Detected

Table 6-4.  Threshold Level Configurations 

Option Description

Set all percentages according to a previously 
saved combination.

Add current settings to the list of popular combi-
nations. Settings are saved when you close the 
window for this tab.

Remove the current selection from the list of 
popular combinations. Settings are saved when 
you close the window for this tab.

Restore percentages to initial defaults.



User Interface – Panels 

107

6.3.3.4 Energy Options

Energy calculations are performed relative to a baseline measurements,
which represents the lowest possible energy.

In integrating the power readings, this baseline is subtracted from each
sample. The options to define the Energy Baseline, are listed in Table 6-5:  

The Energy Options tab is shown in Figure 6-33. These options affect
Pulse Analysis energy calculations.  

Energy is calculated from the sum of the power samples inside the pulse:
the samples from Rise Start Time through Fall Stop Time.

The Energy Baseline is subtracted from measurements for each power
sample when calculating energy, and measurements below this threshold
are ignored. The purpose of this setting is that sometimes the power lev-
els may be artificially elevated, and a non-zero baseline corrects for that

Table 6-5.  Energy Baseline

Option Description

Fixed Zero (0 mW) The Energy Baseline is fixed at literal zero (0 mW) for all 
samples. This is the most common setting for energy 
calculations taken from power measurements.

Lower Cursor Level The Energy Baseline value is determined by the lower 
Horizontal cursor measurement level.

Custom Setting Define a custom value for the Energy Baseline.

Figure 6-33.  Trending – Pulse Analysis – Energy Options Tab
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error. The Energy Baseline usually is zero, but may be overridden with an
explicit value or by making it track the lower bounds of the Selection Cur-
sor.

6.3.3.5 Display Options

Settings in the Display Options dialog box determine how Pulse Analysis
inputs and outputs are displayed in the Trending chart. The default set-
tings are shown in Figure 6-34.  

Any changes are saved on exit and restored at start-up, and are persistent
until settings are again changed.

6.3.3.5.1 Show Pulse Analysis Threshold Levels

There are two categories of annotations in the top half of the dialog box. 

• Analysis Settings: Horizontal lines showing input levels to the analysis
process

• Analysis Results: Horizontal lines showing the results of the analysis

Figure 6-34.  Trending – Pulse Analysis – Display Options Tab
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These settings control the visibility of horizontal line annotations in the
Trending window, which show the current Threshold Level Settings rele-
vant to analysis.

Two additional levels affect Pulse Analysis. These are two dashed solid
dark red horizontal lines, showing the calculated maximum and minimum
levels inside the capture buffer. They correspond to the 0% and 100% lev-
els (although this default maximum may be manually overridden).

Table 6-6 shows the settings for Analysis Settings, which control the visi-
bility of horizontal line annotations in the trend window showing the current
input levels to the analysis process. 

Table 6-7 shows the settings for Analysis Settings. These settings control
the visibility of horizontal line annotations in the trend window showing the
current results levels from the analysis process.  

Table 6-6.  Display Options — Threshold Analysis Settings

Setting Description

Upper Controls visibility of annotations in the Trending window that 
show the current Upper level setting used for analysis.

Middle Controls visibility of annotations in the Trending window that 
show the current Middle level setting used for analysis. 

Lower Controls visibility of annotations in the Trending window that 
show the current Lower level setting used for analysis.

Maximum Controls visibility of annotations in the Trending window that 
show the current Maximum Settings used for analysis. This 
setting controls the level values for the other three thresholds, 
which are based on a percentage of this level.

Energy Base-
line

Calculated energy of the pulse. In Energy calculations, power 
measurements below this baseline value are ignored. Normally 
this baseline is zero, and thus does not affect energy calcula-
tions.
This setting is included for the rare case where power 
measurements are known to be uniformly artificially high. 
In such a case, the baseline may be used to correct the 
measurements in order to accurately compute energy.
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6.3.3.5.2 Show Pulse Analysis Times

Pulse Analysis Times controls the visibility of vertical line annotations in
the Trending window. The vertical lines show the current times of various
events resulting from Pulse Analysis, one for each possible transition in
the analysis process.

Table 6-8 shows the settings for the bottom half of the Display Options di-
alog box: 

Table 6-7.  Display Options — Threshold Analysis Results

Setting Description

Peak Power Peak Power is the largest power measurement inside the 
body of the pulse, with the Peak Power reading recorded for 
each pulse in Energy calculations. This is the maximum 
measurement value found above the upper threshold, regard-
less of the baseline.
• If checked, a horizontal line is drawn in the Trending
window that shows the Mean value of the Peak Power levels
of all the pulses in the analysis region.
• If only a single pulse is selected, then this line shows the
Peak Power level for that one pulse.

Average 
Power

In Energy calculations, an average is computed of all the 
power measurements included in an energy calculation. This 
excludes the power readings prior to the Energy Start time, 
and trailing after the Energy Stop time.
• If this is checked, a horizontal line is drawn in the Trending
window that shows the Mean value of the Average Power
levels of all the pulses in the analysis region.
• If only a single pulse is selected, then this line shows the
mean power level for that one pulse.

Table 6-8.  Display Options — Pulse Analysis Times

Value Description

Rise Time Before the analyzer can begin analyzing a pulse, it needs to see 
one or more samples that are below the Lower threshold. Samples 
prior to that point are ignored. If analysis starts or ends in the middle 
of a pulse, those partial pulses are discounted from the analysis.

Start As soon as a sample is seen that is Above the Lower 
threshold, that marks the start of rise time.

Stop As soon as a sample is seen that is above the High 
threshold, rise time calculation stops.
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6.3.3.5.3 Rise Time

The time between these two events is the pulse's Rise Time. Following the
rise time, the pulse is in the Running State. Rise time calculations may en-
counter zero or more samples between the lower and upper thresholds.
For very fast rise times (that is, one sample below the lower threshold, fol-
lowed by a second sample above the upper threshold), the rise time may
appear to be instantaneous. Such fast rise times necessarily are reported
as zero, which means too fast to measure.

On the other extreme, there may be false starts to rise time (that is, if the
signal rises above the lower threshold, but then falls below it again without
ever crossing the upper threshold)—that is a false start. The analyzer ig-
nores this partial pulse, and resumes searching for the start of another
pulse.

6.3.3.5.4 Fall Time

The actual fall time is a transition below the upper threshold, which even-
tually falls below the lower threshold without ever rising again above the
upper threshold. The pulse is accepted, and added to the accumulate
pulse analysis statistics.

Fall Time The time between these two events is the pulse's Fall Time. 
Following fall time stop, the pulse is in back the Searching State. 

Start As soon as a sample is seen that is Below the Upper 
threshold while running, Fall Time Start marks the possible 
start of fall time.

Stop Once falling, as soon as a sample is seen that is below the 
Lower threshold, Fall Time Stop marks the end of fall time.

Middle 
Crossing

Checking this option causes a vertical line to be drawn where the 
Rising and Falling crossings occur.

Peak 
Power

Time Time stamp for the Peak Power Level sample. (Peak 
Power and Height are the same in the common case 
where the baseline is zero.)
This check box displays a vertical line through the corre-
sponding sample for each pulse in the analysis region. 
The line consists of alternating long and short sections, 
similar to a center line in drafting. 

Table 6-8.  Display Options — Pulse Analysis Times (continued)

Value Description
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The time difference between the crossing of the upper threshold and the
crossing of the lower threshold is reported as the Fall Time for the pulse.
As with Rise time, the Fall Time calculations may encounter zero or more
samples between the upper and lower thresholds. Such fast fall times
necessarily are reported as zero, which means too fast to measure.

Similarly, there may be false starts to fall time (that is, if the signal drops
below the upper threshold but then returns above it -- that is a false start.
The analyzer ignores the false start and waits for another candidate start
of fall time.

6.3.3.5.5 Middle Crossing Time

Separately from—and completely independent of Rise and Fall
times—analysis tracks the times that the middle threshold is crossed. It is
crossed initially sometime during the rise time transition, and finally some-
time during the fall time transition. 

Checking this option causes a vertical line to be drawn where these cross-
ings occur.

These transitions are recorded for whatever use people may have for
them. That is, some consider pulse width to be the time between the two
middle crossings, rather than Rise Start and Fall Stop.

6.3.3.5.6 Peak Power

Peak Power Time, Peak Power level, and overall pulse Height are also
computed by the Energy Calculator. The Height is the Peak Power level
minus the Energy Baseline. (Peak Power and Height are the same in the
common case where the baseline is zero.)

The charts that follow illustrate Peak Power Times and Levels:

• Red dashed lines show the left and right bounds of the analysis.
(The dashed lines also show the upper and lower bounds, too,
which are irrelevant for this example.)

• Peak Power Times are displayed as vertical red annotations
with long and short dashes.

• The Average Peak Power Level is shown by a solid, orange line.
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Figure 6-35 shows how the chart for the Peak Power Level and Peak
Power Time are displayed in the Trending window:  

Figure 6-35.  Peak Power — Levels and Time
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If you move the left and right bounds, the annotations and statistics all
change accordingly, as shown in Figure 6-36: 

6.3.3.6 Analysis Results

An example of the Analysis Results tab is shown in Figure 6-37:  

Figure 6-36.  Peak Power — Shift Bounds

Figure 6-37.  Trending – Pulse Analysis – The Analysis Results Tab
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After a measurement is run, the tab displays more information, as shown
in ’Trending – Analysis Results After Measurement’ (p. 115): 

6.3.3.6.1 Overall Results Summary 

This tab lists a summary of the overall results as well as per-pulse details,
shown in Table 6-9:  

Figure 6-38.  Trending – Analysis Results After Measurement

Table 6-9.  Overall Analysis Results

Option Description

Pulses Detected A count of the number of pulses found.

Overall Duration The overall duration of the sequence of pulses 
analyzed from to Overall Duration Start to Overall 
Duration Stop.

Overall Duration Start The starting time of the first pulse.

Overall Duration Stop The ending time of the last pulse.
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6.3.3.6.2 Pre-Pulse Details

There is one row for each pulse detected, and one additional row for the
Mean values of all rows in each column. Per-Pulse details are shown in
Table 6-10:  

6.3.4 Scaling Dialog Box

The Scaling option defines the maximum and minimum values for both
measurement and time. Use this option to adjust vertical and horizontal
axes for measurement and time, and define the maximum and minimum
values for each.

Table 6-10.  Per-Pulse Analysis Results

Option Description

Index Index of the pulse (1. Count), or “Mean” for the Means row.

Width The width of the pulse, measured as' FallStopTime' minus 
'RiseStartTime'.

Height Equals Peak Power – Baseline.

Energy Energy calculation for this pulse.

Peak Power The maximum power reading of a pulse (without subtracting 
baseline).

Rise Time The time it takes for the signal to transition from below the 
Lower Threshold until above the Upper Threshold, measured 
as 'RiseStopTime' minus 'RiseStartTime'.

Fall Time The time it takes for the signal to transition from above the 
Upper Threshold until below the Lower Threshold, measured 
as 'RiseStopTime' minus 'RiseStartTime'.
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To select this option, click the down arrow next to Scaling in the informa-
tion and options bar directly under the Trending tab. The Trend Chart
Scaling dialog box shown in Figure 6-39 is displayed:  

After a meter is opened, each setting is populated with a selection of val-
ues. Use the drop-down menu shown in the example in Figure 6-40 to
choose the values needed to use for the measurement.  

Close the window by clicking the red ‘x’ in the top-right corner of the dialog
box.

Figure 6-39.  Trending – Scaling Dialog Box

Figure 6-40.  Trending – Scaling Settings Drop-Down Menus
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6.4 Histogram Panel

The Histogram panel is shown in Figure 6-41: 

Displays in the Histogram panel vary, depending on the shape of the sig-
nal (sine wave, square wave, or spikes). A quick view of the Histogram
panel can be used to differentiate or verify the type of signal.

Figure 6-41.  Histogram Panel
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To determine which options are displayed in the Histogram window, select
the drop-down menu for Histogram Settings in the bar above the panel.
The dialog box shown in Figure 6-42 is displayed. Scroll to view all op-
tions:  

There are three areas in which you can change settings in the Histogram
window:

• Specify Number of Histogram Bins

• Specify Histogram Range (Minimum and Maximum)

• Chart Options

6.4.1 Specify Number of Histogram Bins

In this section, select the number of histogram bins to be used for the
analysis. You can choose a value for the number of bins from 2 to 24 from
the drop-down menu.

6.4.2 Specify Histogram Range

A Histogram confines its analysis to a specific range of values. Values in-
side that range are tallied into equal width ‘bins’. 

Figure 6-42.  Histogram – Settings Dialog Box
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• Values above that range are tallied as Over Range.

• Values below that range are tallied as Under Range.

There are several different ways to specify those ranges. Hover over the
individual controls in this section for more detail.

Use the settings listed in Table 6-11 to specify ranges.  

6.4.3 Chart Options

Several options affect the number of columns in the chart. Click a check
box to display columns in the chart, listed in Table 6-12:  

Table 6-11.  Histogram Range

Option Description

Compute range 
from actual data

A Histogram is confined to data between the minimum 
and maximum actual values contained in the current 
buffer.
• Data below the minimum is classified as Under Range.
• Data above the maximum is classified as Over Range.

Use current 
measurement 
range

A Histogram is confined to data between 0 (the minimum 
value) and the maximum value in the currently selected 
operating range.
• Data below 0 is classified as Under Range. 
• Data above the maximum range is classified as
Over Range.

Explicit range A Histogram is confined to data between the two explicit 
values that you enter. 
• Data below the minimum is classified as Under Range.
• Data above the maximum is classified as Over Range.

Table 6-12.  Chart Options

Option Description

Show Over-Range 
Measurements

Displays a column summarizing the number of Over Range 
samples.

Show 
Under-Range 
Measurements

Displays a column summarizing the number of 
Under Range samples.
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6.4.4 Save/Export Histogram Data

After you take measurements, right-click in the Histogram window to dis-
play a pop-up menu. This allows users to:

• Export Histogram Data to File, or

• Save Histogram Image to File

These commands display a standard Windows dialog box, where you can
browse to the location to save the exported file or Histogram image. 

Specify a unique destination file name so files are not over-written with lat-
er actions to Export or Save.

6.5 Beam Position Panel

The Beam Position window is shown in Figure 6-43: 

The Beam Position window shows the current beam position in real time,
and charts the x and y offsets as a function of time. This window is avail-
able only when used with position-sensing thermopile sensors.

Use the Zoom feature in this window using the drop-down menu near the
top of the Beam Position tab window.

Show Missing 
Pulses

Displays a column summarizing the number of Missing 
Pulses found in the Histogram data.

Exclude Negative 
Values

Chart displays a column summarizing the number of nega-
tive samples in the Histogram data.
Power and Energy measurements theoretically cannot be 
negative. However, samples may occur in practice due to 
electrical noise, calibration, and other errors. Use this 
option to exclude negative values from analysis; otherwise, 
negative values are included and affect the results.

Table 6-12.  Chart Options (continued)

Option Description
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6.6 Diagnostics Panel

NOTICE
This panel is only visible when a sensor device that supports these
features is used.

This tab shows water flow rates and temperatures for supported sensors
such as the PowerMax 10kW/15kW Sensors. Refer to the example in
Figure 6-44.

For more details about flow rate and temperature plots, refer to the user
manual for the sensor being used.

Figure 6-43.  Beam Position Panel



User Interface – Panels 

123

Figure 6-44.  Diagnostics Panel



Coherent Meter Connection User Manual

124



Statistics and Pulse Analysis 

125

7 Statistics and Pulse Analysis

This  sect ion  descr ibes the Sta t is t ics  pane l  in  the Coherent
Meter Connection software.

The Statistics panel always shows the actual number of trigger events
present in the buffer at the time the display updates. The Statistics panel
provides data for:

• ’Buffer Statistics’ (p. 126)

• ’Selection Bounds’ (p. 129)

• ’Selection Statistics’ (p. 132)

• ’Pulse Analysis’ (p. 135)

For information about how to take measurements using the Coherent
Meter Connection software, see ’Measurement Modes’ (p. 141).
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7.1 Buffer Statistics

Figure 7-1 shows the Buffer Statistics section of the Statistics panel.
These statistics are computed for the entire contents of the Capture buffer.  

Table 7-1 describes the Buffer Statistics section: 

Figure 7-1.  Statistics – Buffer Statistics Panel

Table 7-1.  Description of Buffer Statistics

Statistic Description

Count The total number of samples used to calculate these statistics.

Live The most recent sample in this collection of samples.
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Mean (μ) The arithmetic mean -- the sum of all measurements divided by total number of 
samples (Count). 

Min Minimum – The numerically smallest of all measurements. 

Max Maximum – The numerically largest of all measurements.

Filtered A simple filter applied to the most recent 32 samples.

StdDev (σ) Standard Deviation, represented by the Greek letter sigma (σ), is a measure of how 
much sample data varies from its mean.
• A low standard deviation indicates that most of the data tend to be very close to the

mean.
• A high standard deviation indicates that the data are dispersed much more widely

around the mean.
It is common to consider a normalized version of standard deviation (σ) by dividing it 
by the mean of the sample data (µ). Some intervals are two or three standard devia-
tions wide.

σ/μ

2σ/μ 
(Stability)

3σ/μ

Over Range A count of how many samples were marked Over Range by the meter. Samples are 
so-marked if they come within 90% of the maximum possible value that can be repre-
sented by the measurement electronics.
Over Range indicates that measurement precision can be improved when a higher 
fixed range is set. If the meter is already in the highest range, then it indicates that the 
measurement capacity of the instrument has been exceeded.

Over Temp A count of how many samples were marked Over Temperature by the meter. 
Samples are so-marked if their reported temperature exceeds a maximum threshold 
that is appropriate for that sensor.
Over Temperature indicates that the sensor is overheating, and that it must be cooled 
down before continued use. 
CAUTION! Failure to do so can damage the sensor.

Under 
Range

Meter flags samples that are too small for the current fixed range.
Under Range indicates that measurement precision can be improved when a lower 
fixed range is set.

Triggers A count of all the samples in the capture buffer that match the trigger criteria, as spec-
ified in the Trigger tab.

Table 7-1.  Description of Buffer Statistics (continued)

Statistic Description
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Figure 7-2 shows the context menu available when you right-click in the
Buffer Statistics section of the panel. All statistics are enabled (displayed)
by default. Toggle the check box next to selected statistics to show or hide
that option.  

Missed Missed Pulses — In High-Speed Energy Mode, the measurement hardware expects 
a pulse to be displayed inside each Measurement Window. If an expected pulse is not 
detected, then the corresponding sample is marked as having a missing pulse. The 
measurement hardware is reset and begins searching for the next pulse. A typical 
remedy for Missed Pulses is to increase the Window Size on the Measurement tab.

Missing Missing Samples – Sometimes the PC software cannot keep up with the data stream 
from the instrument, and a buffer internal to the instrument overflows. When this 
happens, the meter firmware flags some of the subsequent samples as “Missing” to 
indicate where in the data stream this omission happened.
The missing data is lost forever and cannot be recovered. One remedy to prevent 
missing samples is to increase the Decimation setting on the Measurement tab. (A 
setting of 2 or 3 is usually sufficient.) Also make sure that no other applications are 
running and that computer resources are devoted to this application.

Table 7-1.  Description of Buffer Statistics (continued)

Statistic Description
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7.2 Selection Bounds

NOTICE
For standalone meter use, this section only applies with the use of the
LabMax Pro SSIM and LabMax Touch Pro meters combined with a
PowerMax Pro sensor. 
It also applies to the USB/RS PowerMax Pro sensors.

Selection Bounds are only available when cursors are enabled and the
meter is not running. These are properties of the boundaries for the se-
lected region, as determined by the position of the cursors.

Figure 7-2.  Statistics – Buffer Statistics Context Menu
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NOTE: When taking a measurement with a pyroelectric sensor, the
Selection Bounds panel displays Pulse ID Axis values (rather than
Time Axis values).

Cursors are enabled or disabled on the Trending window. Vertical lines
represent sample time positions and horizontal lines represent measure-
ment levels.

To enable or disable Selection Bounds Cursors:

1. Right-click in the Trending window to display the context menu.

2. Verify that the check box is selected to show the Show Selection
Bounds Cursors.

Figure 7-3 shows the options in the Selection Bounds section of the Statis-
tics panel:  

Table 7-2 describes the statistics in the Selection Bounds section: 

Figure 7-4 shows the context menu available when you right-click in the
Selection Bounds section of the Statistics panel. All statistics are enabled
(displayed) by default. Toggle the check box next to selected statistics to
show or hide that option.  

Figure 7-3.  Statistics – Selection Bounds Panel
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Table 7-2.  Statistics for Selection Bounds

Axis Statistic Description

Ti
m

e

Left Left cursors are Vertical line that mark the leftmost/smallest Time-Axis value 
for the selected region.

Right Right cursors are Vertical line that mark the rightmost/largest Time-Axis value 
for the selected region.

Width Displays the time interval between the left and right cursors.

M
ea

su
re

m
en

t

Left Value Displays the measurement value of the leftmost/first value in the selected 
region.

Right 
Value

Displays the measurement value of the rightmost/last value in the selected 
region.

Top The Top cursor position is a Horizontal line that indicates the topmost/largest 
Measurement-Axis value for the selected region.

Bottom The Bottom cursor position is a Horizontal line that indicates the 
lowest/smallest Measurement-Axis value for the selected region.

Height The Cursor Height displays the difference in amplitude between the Top and 
Bottom cursors.
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7.3 Selection Statistics

NOTICE
For standalone meter use, this section only applies with the use of the
LabMax Pro SSIM and LabMax Touch Pro meters combined with a
PowerMax Pro sensor. 
It also applies to the USB/RS PowerMax Pro sensors.

These statistics are computed for the buffer contents in the selected re-
gion, as determined by the position of the Cursors.

Selection Statistics are only available when cursors are enabled and the
meter is not running. Cursors are enabled or disabled on the context
menu in the Trending window. 

Figure 7-5 shows the Selection Statistics section of the Statistics panel. 

Table 7-3 describes the Selection Statistics section:  

Figure 7-4.  Statistics – Selection Bounds Context Menu
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Figure 7-5.  Statistics – Selection Statistics Panel

Table 7-3.  Description of Selection Statistics

Statistic Description

Samples Total number of samples in the selected region. 

Maximum Maximum amplitude of the samples in the selected region.

Above Total number of samples in the selected region with amplitude higher than the top 
Cursor.

Minimum Minimum amplitude of the samples in the selected region.

Below Total number of samples in the selected region with amplitude lower than the bottom 
Cursor.

Baseline Displays the amplitude being used as the minimum level for energy computations. 
The baseline can either be fixed at 0.0 or assigned the amplitude of the bottom 
Cursor. 

Energy Displays the calculated energy of the waveform in the selected region. The calcula-
tion is an integration of the power readings over the time interval inside the selection. 
The calculation yields NaN if the selected region does not contain power measure-
ments.
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Figure 7-6 shows the context menu available when you right-click in the
Selection Statistics section of the panel. All statistics are enabled (dis-
played) by default. Toggle the check box next to selected statistics to
show or hide that option.  

Pulse Count Pulses displays the number of pulses (trigger events) contained in the selected 
region. [For all of these ‘pulse’ entries we will specify applicability for LM Touch Pro 
vs non-Pro models - coming from Peter]

Pulse Energy Displays the average energy of the pulses in the selected region. This is calculated 
from the total energy in the region divided by the number of pulses (trigger events). 
This calculation is more realistic if the Snap To Triggers setting is selected in the 
context menu for the Trending window.

Pulse Width Displays the average width of the pulses in the selected region. It is calculated from 
the total width (time) of the region divided by the number of pulses (trigger events). 
This calculation does not depend on Snap To Triggers setting.

Pulse Period Displays the average period of the pulses in the selected region. It is calculated from 
the width (total time) of the region divided by the number of pulses (trigger events). 
This calculation is more realistic if the Snap To Triggers setting is selected in the 
context menu for the Trending window.

Pulse Rate Displays the average frequency of the pulses in the selected region, calculated from 
the inverse of the Pulse Period. This calculation is more realistic if the Snap To Trig-
gers setting is selected in the context menu for the Trending window.

Table 7-3.  Description of Selection Statistics (continued)

Statistic Description
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7.4 Pulse Analysis

NOTICE
For standalone meter use, this section only applies with the use of the
LabMax Pro SSIM and LabMax Touch Pro meters combined with a
PowerMax Pro sensor. 
It also applies to the USB/RS PowerMax Pro sensors.

A Pulse is defined as a sequence of measurements that start below the
lower threshold, rise above the upper threshold, and eventually fall down
again below the lower one.

Pulse Analysis is the detection of pulses and computing various statistics
about their shape and timing. The statistics in this section are valid only if
Pulse Analysis is enabled in the context menu in the Trending window. For
details about Pulse Analysis options, see ’Analysis Options’ (p. 99).

Figure 7-6.  Statistics – Selection Statistics Context Menu



Coherent Meter Connection User Manual

136

To enable or disable Pulse Analysis:

• Right-click in the Trending window to display the Trending window
context menu, and select the “Pulse Analysis Enabled” option.
(or)

• Click the check box at the bottom of each tab inside the Analysis
Options Settings dialog box.

Figure 7-7 shows the Pulse Analysis section of the Statistics panel: 

Table 7-4 shows the statistics in the top half of the Pulse Analysis section:  

Measurement Thresholds are used to detect pulses and calculate these
statistics. The upper and lower thresholds are used to detect individual
pulses and to calculate their Rise Time and Fall Time statistics.

Figure 7-7.  Statistics – Pulse Analysis Panel
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Table 7-4.  Statistics for Pulse Analysis

Statistic Description

Pulse Count The total number of pulses detected in the current selection.

Rise Time Rise Time is the time the signal takes from the lower threshold to the upper. The 
statistic represents the average rise time of the pulses found in the current selection.

Fall Time Fall Time is the time signal takes from the upper threshold to the lower. The statistic 
represents the average fall time of the pulses found in the current selection. 

Mean Width Pulse Width is measured between the upward and downward crossings of the Middle 
Threshold. The Mean Width represents the average pulse width of the pulses found 
in the current selection.

Mean Height Height is Peak Power minus the Baseline. The Baseline defaults to zero, in which 
case Height is the same as Peak Power. A user sets the Baseline to some other 
value (for example, to compensate for such things as excess ambient light).
Pulse analysis detects multiple pulses (0 or more) in a single analysis. For many of 
the statistics, CMC reports the averages of all the pulses (hence “Mean Height” 
instead of Height), which means the mean (numerical average) of all the pulses in the 
selected region. The Results Table tab shows the corresponding statistics for each 
individual pulse.

Mean Energy The average energy of the pulses found in the current selection.

Total Energy The total energy of the pulses found in the current sample.
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The lower half of the Pulse Analysis Statistics panel includes Measure-
ment Thresholds, shown in Table 7-5:  

On occasion, data transmission or other errors corrupt the measurement
data, resulting in measurement values which are patently not legitimate.
When this happens, the samples in question are marked by the software.

Figure 7-8 shows the context menu available when you right-click in the
Pulse Analysis section of the Statistics panel. All statistics are enabled
(displayed) by default. Toggle the check box next to selected statistics to
show or hide that option.  

Table 7-5.  Statistics for Measurement Thresholds in Pulse Analysis

Statistic Description

Maximum The maximum threshold used to translate threshold percentages to measurement level 
values. It defaults to the maximum actual value found in the selected range.

Upper The upper threshold level is used to detect pulses and calculate Rise- and Fall-time 
statistics.

Middle The middle threshold level is used to detect pulses and calculate pulse width statistics.

Lower The lower threshold level is used to detect pulses and calculate Rise- and Fall-time 
statistics.

Baseline The Energy Baseline is used to exclude power measurements that are smaller than 
this given threshold level. Normally it is zero, but may be used in unusual circum-
stances to exclude power measurements below a given level.

Upper% The upper threshold, expressed as a percentage between the minimum and maximum 
values found in the capture buffer.

Middle% The Middle threshold, expressed as a percentage between the minimum and maximum 
values found in the capture buffer.

Lower% The Lower threshold, expressed as a percentage between the minimum and maximum 
values found in the capture buffer.
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7.5 Export Statistics for Analysis

Users can export statistics and computations to a separate file for later
viewing/analysis. This applies to each section of the Statistics panel:

• Right-click in the Statistics panel and, from the context menu, select
the needed option
(or)

From the Main Menu drop-down menu, select Import/Export and then se-
lect the needed option.

Figure 7-8.  Statistics – Pulse Analysis Context Menu
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8 Measurement Modes

This section shows how to use the Coherent Meter Connection software
to take measurements at different speeds and with different equipment.

For more information about the features of the software, as well as devic-
es supported, see ’User Interface – Main Controls’ (p. 21).

8.1 Overview of Measurement Modes

The Coherent Meter Connection software offers the following Power mea-
surement modes:

• Basic Mode (p. 145), also referred to as Standard Mode, a nearly
instant average power reading at a 10 Hz sampling rate

• High-Speed Mode (p. 150), a high-speed power reading streaming at
20 kHz 

• Snapshot Mode (p. 153), a burst of high-resolution power data
sampled at 625 kHz or 1.6 microseconds per sample

Each of these are shown in the next sub-sections, with step-by-step in-
structions following the overview.

For information about taking an Energy measurement, see p. 160.

8.1.1 Basic Measurement Mode Overview

The Basic power measurement mode for the LabMax-Pro SSIM uses a
typical 10 Hz sampling rate.

This mode is best used to measure the average power of either Continu-
ous Wave (CW) lasers or the average power of high-repetition rate
(pulsed) lasers.

• In10 Hz sampling mode, PowerMax-Pro sensors supply an almost
instantaneous power reading, similar to a photodiode, while also
taking advantage of the sensor's ability to directly read very high
powers. 

However, because data is sampled every 100 milliseconds, temporal
pulse information is not displayed. To view temporal information, use
High-Speed Mode instead.
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• When measuring the average power of high repetition rate,
short-pulsed lasers such as picosecond, femtosecond, and nano-
second lasers, it is best to operate in Basic mode because:

• Ultrafast and q-switched laser pulses are too fast for
PowerMax-Pro to resolve temporal pulse information.

• High-Speed Mode sampling rates tend to alias with the high kHz
pulse repetition rates.

8.1.2 High-Speed Measurement Mode Overview

NOTICE
For standalone meter use, this mode only applies with the use of the
LabMax Pro SSIM and LabMax Touch Pro meters combined with a
PowerMax Pro sensor. 
It also applies to the USB/RS PowerMax Pro sensors.

High-speed mode operates at a continuous data sampling rate of 20 kHz,
permitting pulse shape analysis of modulated lasers with repetition rates
up to 2.5 kHz.

These types of pulse trains are common in many laser-based material
processing applications, such as micro welding. This mode can also be
useful to view the settling times of Continuous Wave lasers after the laser
is fired.

• A data point is sampled every 50 microseconds, making this mode
very useful for real-time visualization of temporal shape of modulated
lasers with pulse lengths hundreds of microseconds or longer. This
mode also provides fast feedback about changes in power output
from Continuous Wave sources.

• To prevent aliasing effects between the meter sampling rate and the
laser pulses, High-Speed Mode cannot be used with lasers modu-
lated at over 2.5 kHz pulse repetition frequency.

• High-Speed Mode is also used to determine the appropriate trigger
level in or for Snapshot Mode. High-Speed Mode can be used to
confirm that the LabMax-Pro SSIM meter is accurately triggering on
the laser pulses before moving into Snapshot Mode.

Figure 8-1 shows data collected using a CO2 laser to illustrate the type of
detail using High-Speed Mode.  
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8.1.3 Snapshot Measurement Mode Overview

NOTICE
For standalone meter use, this mode only applies with the use of the
LabMax Pro SSIM and LabMax Touch Pro meters combined with a
PowerMax Pro sensor. 
It also applies to the USB/RS PowerMax Pro sensors.

A faster high-speed sampling mode, called Snapshot Mode, provides
burst sampling at a rate of 625 kHz for a maximum of 384 milliseconds.

Figure 8-1.  Examples Using High-Speed Mode
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This mode lets you see the temporal characteristics of modulated pulses
used in commercial cutting, engraving and drilling applications, as well as
long pulses and pulse trains used in aesthetic medical applications.

The temporal detail in Snapshot Mode illustrates the true performance of
the laser—previously masked by slow thermopiles— thereby providing
more information to help set up process recipes and monitor system per-
formance in manufacturing.

Figure 8-2 shows the data quality and high pulse shape fidelity that is
achievable. This example is a snapshot based on:

• Modulated 10.6 μm CO2 Laser

• 50 μSec PW

• 8 kHz PRF

• 40% Duty Cycle 

Figure 8-2.  Example Using Snapshot Mode
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For more information about the Snapshot process, sample size, and so
on, see ’Take a Snapshot Measurement’ (p. 153).

8.2 Before You Begin

This section assumes that you have already:

• Set up applicable laser safety control measures

• Installed and connected all hardware and components

• Installed the Coherent Meter Connection software and are familiar
with the user interface

There are no user adjustments in the sensor itself. 

The sensor can only be calibrated by returning the sensor to Coherent;
see ’Maintenance and Support’ (p. 197).

The Coherent Meter Connection software includes a gain adjustment fea-
ture; this does not affect the calibration. This feature is intended to allow
for a bias “offset” to be created by the user to allow for things such as
compensating for optical losses in the beam path leading up to the point of
measurement, or to align two different measuring systems.

8.3 Take a Basic Power Measurement

This section shows the steps to take a basic power measurement at a
10 Hz sampling rate. This procedure can be sued with a LabMax Pro
SIMM meter, a LabMax Touch/Touch Pro meter, or with a meterless
USB/RS sensor.

To take a basic measurement:

1. Set up the meter or meterless sensor and then set the power to On.

2. Double-click the shortcut icon to start the Coherent Meter Connection
software.
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WARNING!
Follow all laser safety procedures. Use of controls or adjustments or
performance of procedures other than those specified may result in
exposure to hazardous radiation.

Make sure to either set the laser to OFF or block the beam until you
are ready to take a power measurement.

3. [Home tab] To take a basic power measurement, make sure that the
check box for High-Speed Mode is not checked in the Home tab, as
shown in Figure 8-3: 

4. [Data Buffer tab] For a basic power measurement, select or change
the following settings in the Data Buffer tab, as shown in Figure 8-4: 

a.) [Data Buffer tab] In the Capacity field, enter a value that
represents the sample size you want to collect. This value is
also the sample size used to calculate Statistics.

b.) [Data Buffer tab] For the Continuous Mode check box:

• Click the check box if you want data collection to continue
until you manually stop it. 

• Deselect the check box to have data collection end after
the Data buffer is full (when it reaches the value in the
Capacity field).

Figure 8-3.  Home Tab

Figure 8-4.  Data Buffer Tab
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5. [Measurement tab] For a basic power measurement, select or
change settings in the Measurement Tab, as shown in the example in
Figure 8-5:  

• Select the laser Wavelength from the drop-down menu. If the
laser wavelength is not available, choose the setting that is
closest to it. 

• Alternatively, edit the Wavelength table to add the new setting to
the drop-down menu, shown in Figure 8-6. 

6. [Trending tab] Click the Trending tab in the lower half of the window
to display the Graphics viewing panel, shown in Figure 8-7.  

7. Turn on the laser and expose the sensor to the laser beam.

WARNING!
Exposure to laser radiation can be harmful. Direct eye contact with the
output beam from a laser WILL cause serious eye injury and possible
blindness. Follow all safety precautions; see ’Safety and Compliance’
(p. 173).

Figure 8-5.  Measurement Tab

Figure 8-6.  Select Wavelength
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8. [Quick Access toolbar or Home tab]:

a.) To begins data collection, press the Start icon in the toolbar or
the Home tab, shown in Figure 8-8. 

b.) To end data collection, click the Stop icon in the toolbar or the
Home tab, shown in Figure 8-9. 

Figure 8-7.  Trending Tab

Figure 8-8.  Start Data Collection

Figure 8-9.  Stop Data Collection
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The example in Figure 8-10 shows how and where information is
displayed during data collection:

• Data is visible in the Trending chart.

• The panel displays a live reading.

• Statistics in the sidebar on the right are updated in real time
(based upon data entering the buffer).

You can view the Trending chart and Statistics to see the overall
minimum and maximums for the data.

9. In the [Home tab], click an icon to export or clear the capture. You can
also click the Clear icon in the Quick Access toolbar, shown in
Figure 8-11.

Figure 8-10.  Main Window



Coherent Meter Connection User Manual

150

8.4 Take a High-Speed Measurement

This section shows how to take a high-speed power measurement at a
20 kHz sampling rate.

To take a high-speed measurement:

1. Double-click the shortcut icon to run Coherent Meter Connection soft-
ware.

WARNING
Make sure either the laser is OFF or the beam is blocked until ready to
take a power measurement.

2. [Home tab] To take a high-speed measurement, select or change the
following settings in the Home tab. Make sure that the check box for
High-Speed Mode is checked. 

3. [Home tab] Click the Range drop-down menu shown in Figure 8-12,
and select one option from the list:  

The number of ranges listed depends on the sensor used; some
sensors offer more than two ranges.

• AUTO is generally used only for a single range in slow speed. 

Figure 8-11.  Export or Clear Data

• AUTO (for auto-range)

• A fixed range for Low power limits

• A fixed range for High power limits

Figure 8-12.  Settings for High-Speed Mode
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• AUTO is not allowed in Snapshot or non High-Speed Mode
operations.

4. [Home tab] Press the Zero button to measure the baseline value of
the sensor. A dialog box displays the process to reset to zero; this
takes only a few seconds. To set the meter to zero, the laser must be
turned OFF (or the beam blocked).

5. [Data Buffer tab] For a high-speed measurement, select or change
the following settings in the Data Buffer tab:

6. [Data Buffer tab] In the Capacity field, enter a value that represents
the sample size you want to collect. This value is the sample size
used to calculate Statistics.

7. [Data Buffer tab] For the Continuous Mode check box:

• Click the check box if you want data collection to continue until
you manually stop it.

• Deselect the check box to have data collection end after the
Data buffer is full (when it reaches the value in the Capacity
field).

8. [Data Buffer tab] Make sure that the check box for Snapshot Mode
is not checked.

9. [Measurement tab] Select the laser wavelength from the drop-down
menu. 

• Select the laser Wavelength from the drop-down menu. If the
laser wavelength is not available, choose the setting that is
closest to it.

• Alternatively, edit the Wavelength table to add the new setting to
the drop-down menu.

10. [Trending tab] Click the Trending tab in the lower half of the window
to display the Graphics viewing panel.

11. Set the laser to ON and then expose the sensor to the laser beam.

WARNING!
Exposure to laser radiation can be harmful. Direct eye contact with the
output beam from a laser WILL cause serious eye injury and possible
blindness. Follow all safety precautions; see ’Safety and Compliance’
(p. 173).

12. [Quick Access toolbar or Home tab] To begin data collection, press
the Start icon in either the toolbar or the Home tab.

Information is displayed as follows during data collection:

• Data is visible in the Trending chart.

• The panel displays a live reading.
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• Statistics in the sidebar on the right are updated in real time
(based upon data entering the buffer).

13. [Trending tab] The loading indicator at the bottom of the Graphics
viewing panel displays in green while data is loading, as shown in
Figure 8-13.  

TIP: If the application displays a ‘Missing’ warning during data collec-
tion, it means data was lost while transferring the data in real time
from the meter's buffer to the PC.

This usually occurs because the computer is not able to keep up with
the high rate of data continuously streaming from the meter. To
prevent this:

• Make sure that the USB connection is a USB 2.0 High-Speed
port, and then close other open applications.

• Reduce the Capacity buffer size.

• Export the data file to examine the error indicators to determine
where and how much data was lost.

14. [Quick Access toolbar or Home tab] To end data collection, click the
Stop icon in either the toolbar or the Home tab.

15. Zoom in or out to view measurements in the Trending chart.

16. In the [Home tab], click the icons to either export or clear the
measurement.

Figure 8-13.  Loading Trending Data
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8.5 Take a Snapshot Measurement

This section shows how to take a Snapshot power measurement.

Snapshot Mode is a special acquisition mode that captures high-speed
data at (example: 625 kHz or 1.6 microseconds per sample - capture rate
to the internal buffer inside the meter). Refer to the user manual for the re-
spective meter being used for measurement for sample rate values.

NOTICE
To prevent aliasing effects between the meter sampling rate and the
laser pulses, do not use this mode with lasers modulated at over
80 kHz pulse repetition frequency.

Due to the high rate of data acquisition in this mode, it is necessary to
temporarily store the data in the instrument’s hardware buffer, as it is not
possible to upload it in real-time through the USB connector.

After data acquisition is complete, the instrument uploads the data to the
PC, where it is placed in the Capture buffer and displayed in the software.

8.5.1 Snapshot Sample Size

Depending on the meter being used, there is a maximum size of the
Snapshot, for example: 240,000 samples - 384 milliseconds of data col-
lection). Refer to the respective user manual for the meter being used for
maximum sample values.

Users can request a snapshot of any number of samples up to a specified
sample rate. This is done by adjusting the buffer Capacity setting in the
Data Buffer tab. This field does not allow an entry greater than the limit as-
sociated with the meter being used, when Snapshot Mode is enabled

A smaller number of samples reduces the time to collect and upload them,
and speeds up the response that displays on the user interface. A sample
size that is set too small may not result in a collection window that is not
long enough to view your entire pulse.

The 240,000 samples can be divided between pre-trigger samples and
regular (post-trigger) samples as follows:   0 ≤ pre-trigger ≤ capacity
≤ 60000 and 1 ≤ capacity.

The Snapshot mode sample rate is 1.6 µSec/sample.

Coherent Meter Connection software allows users to specify the pre-trig-
ger size and the total size, either in number of samples or microseconds
(rounded to the nearest 1.6).
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Preview mode is disabled when Snapshot mode is enabled. The user in-
terface is updated at the completion of each Snapshot buffer upload.

It takes approximately a third of a second for the meter to acquire
240,000 samples and another 12 seconds to upload the data. That is, it
takes approximately 12.3 seconds before users can view the data. A
smaller number of samples require proportionally less time to display the
data.

Also see information about ’Show Trigger Markers’ (p. 90). 

8.5.2 Overview of the Snapshot Process

During Snapshot Mode, the hardware waits for a trigger event before ac-
quiring data. There is no preview of the data when waiting for a trigger.
The recommended sequence is as follows:

1. Configure the laser and sensor for measurement.

2. Configure data acquisition settings on the LabMax-Pro SSIM or
LabMax Touch Pro meter initially only in High-Speed Mode. This
shows the presence of triggers, or data even in the absence of trig-
gers.

3. Fine-tune trigger levels in High-Speed Mode, then change settings on
the meter to Snapshot Mode.

4. Start the meter.

5. Start the laser, which triggers data acquisition. When a trigger is
found, the meter starts filling the Capture buffer. 

6. If a trigger event is not automatically detected, press the Force Trigger
button at the bottom of the panel to manually acquire a Snapshot.

7. When the buffer is full, data is sent to the user interface and displayed
in the Graphics viewing panel on the Trending tab.

In practice, it can take some experimentation to determine the various set-
tings and appropriate trigger levels. 

• If you check the Continuous mode check box, the meter auto-
matically loops. 

• If Continuous mode is not selected, the meter stops and awaits
further instructions.

The duration of a Snapshot depends on the laser pulse length and the
number of pulses you want to capture.
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8.5.3 Procedure: Define Settings

The first part of the procedure is done in High-Speed Mode to define the
data acquisition settings, including trigger settings. 

1. Double-click the shortcut icon to run Coherent Meter Connection soft-
ware.

WARNING!
Make sure that either the laser is turned OFF or the beam is blocked
until you are ready to take a power measurement.

2. [Home tab] For a Snapshot measurement, first configure only
High-Speed Mode in the Home tab to take trial measurements:

a.) [Home tab] Make sure that the check box for High-Speed
Mode is checked.

b.) [Home tab] Click the Range drop-down menu and select either
of the fixed ranges. (This signifies the maximum power limits for
each range.) Snapshot does not support Auto ranging.

c.) [Home tab] Click the Zero button to measure a baseline value
for the sensor. A dialog box displays the process to set to zero;
this takes only few seconds. 

WARNING!
Before you the meter is set to zero, make sure either the laser is
turned OFF or the beam is blocked.

[Data Buffer tab] To take initial trial measurements in High-Speed Mode,
select or change the following settings in the Data Buffer tab:
3. [Data Buffer tab] Enter a value in the Capacity field that represents

the sample size you want to collect.

NOTE: A setting of 20,000 represents one second of data collection,
which is adequate to set up Snapshot Mode.

This value is also the sample size used to calculate Statistics. The
purpose of this step is to confirm good data collection and correct
pulse triggering.

• If this setting is 0 (zero), Snapshot begins at the time of the
trigger event, which occurs after the first pulse begins.

• If you want to capture the portion of the first pulse before the
trigger event, add in some pre-trigger samples.

4. [Data Buffer tab] Make sure that the check box for Continuous
Mode is checked.
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5. [Data Buffer tab] Make sure that the check box for Snapshot Mode
is not yet checked.

6. [Measurement tab] Select the laser Wavelength from the drop-down
menu. 

• Select the laser Wavelength from the drop-down menu. If the
laser wavelength is not available, select the setting that is
closest to it. 

• Alternatively, edit the Wavelength table to add the new setting to
the drop-down menu.

7. [Trigger tab] Enter a Level setting in Watts that represents a level
approximately 50% between zero and the Peak Power you expect
each pulse to have. 

Any trigger setting between the data minimum and maximums causes
a trigger. The Trigger Tab is shown in Figure 8-16.  

If the Peak Power is not known, enter a Level setting between zero
and the average power.

8. Make sure that Trigger settings are correct:

Figure 8-14.  Data Buffer Tab

Figure 8-15.  Measurement Tab

Figure 8-16.  Set Trigger Levels
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• Source is set to Internal.
• Edge is set to Positive.

• Delay is set to 0 (zero).

9. [Trending tab] Right-click inside the Graphics viewing panel to
display a pop-up menu, shown in Figure 8-17. Select Show Trigger
Markers. This setting confirms that the meter is auto triggering on the
pulses. 

This setting is available only if there is data in the buffer, and remains
in effect until you change it. If there is no data, first run a trial measure-
ment, then select Show Trigger Markers.

10. Turn on the laser and expose the sensor to the laser beam.

WARNING!
Exposure to laser radiation can be harmful. Direct eye contact with the
output beam from a laser WILL cause serious eye injury and possible
blindness. Follow all safety precautions; see ’Safety and Compliance’
(p. 173).

Figure 8-17.  Show Trigger Markers
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8.5.4 Procedure: Trial Measurement

To start a trial measurement:

1. [Quick Access toolbar or Home tab] Press the Start icon in the
toolbar or the Home tab. 

2. [Quick Access toolbar or Home tab] To end the measurement,
press the Stop icon in the toolbar or the Home tab.

3. [Trending tab] After the data is loaded, the result for the trial
measurement is plotted in the Trending chart.

4. Confirm that each pulse has a trigger marker. This is represented by
a magenta vertical line plotted at each trigger event, as shown in
Figure 8-18. 

• If the magenta trigger markers are not visible, or are not consis-
tently triggering on each pulse event, adjust the Trigger Level
setting in that tab.

• The green line in the Trending chart represents the trigger
threshold level.

5. Continue to do trial measurements again until trigger events are
occurring as expected.

8.5.5 Procedure: Take a Snapshot

After trigger events are occurring and pulses are displaying properly,
move into Snapshot Mode.

Figure 8-18.  Display Trigger Markers
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To take a Snapshot measurement:

1. [Data Buffer tab] Click the check box for Snapshot Mode.

If settings (such as Range and Data Buffer) are not configured
correctly and Snapshot Mode is selected, the dialog box shown in
Figure 8-19 is displayed that indicates any errors:

To resolve, click the Confirm Changes button, and Coherent
Meter Connection software automatically adjusts the settings.

2. Set the laser to On and then expose the sensor to the laser beam.

WARNING
Exposure to laser radiation can be harmful. Direct eye contact with the
output beam from a laser WILL cause serious eye injury and possible
blindness. Follow all safety precautions; see ’Safety and Compliance’
(p. 173).

3. [Quick Access toolbar or Home tab] To begin a measurement in
Snapshot Mode, press the Start icon in the toolbar or the Home tab.

A Snapshot Mode icon is displayed in the Status bar at the bottom of
the Trending window. The Status bar is blank when the buffer is
loaded in Non-Continuous mode or if Stop is pressed.

• As shown in Figure 8-20, a red oscillating bar displays until the
laser fires and a trigger event is detected.

Figure 8-19.  Snapshot Mode Setting Conflicts
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• When a trigger event is detected, the Snapshot Mode bar turns
green, as shown in Figure 8-21. 

This bar actively displays the progress of loading the data from
the internal Snapshot buffer in the meter to the PC application.
Loading can take several seconds, depending upon the size of
the Snapshot Capacity setting. 

If a trigger event does not occur, the system stays in the waiting state
(the Snapshot icon displays the red waiting mode). If this happens,
either:

• Press Stop to end data collection, and exit Snapshot mode.
Return to High-Speed Mode, and adjust trigger settings as
needed. 
(or)

• Press the Force Trigger button (on the oscillating bar). This
forces the meter to collect Snapshot data, whether or not it finds
a trigger.

Also, check if the Show Trigger markers menu option is enabled
to make sure that triggers are occurring as expected before
entering Snapshot mode.

4. [Quick Access toolbar or Home tab] To end data collection, press
the Stop icon in the toolbar or the Home tab.

8.6 Take an Energy Measurement (Joules)

The Coherent Meter Connection software measures Energy with Power
Sensors using a technique called Long Pulse Energy Mode (LPEM). This
is selected in the Trigger tab toolbar; for more information, see ’Trigger
Tab’ (p. 63).

The sensors themselves can only directly measure power. The meter firm-
ware detects the start and end of a pulse, and integrates the intervening
power readings to calculate an energy measurement for the pulse.

Figure 8-20.  Snapshot Mode — Waiting for Trigger

Figure 8-21.  Snapshot Mode — Loading Data
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With "Trigger Tab" (p. 63), Long Pulse Energy Mode is selected by re-
questing Energy mode from a Power sensor.

However, the behavior of the user interface is different for PowerMax
USB/RS (‘meterless’) sensors than for the LabMax-Pro SSIM or Power-
Max-Pro USB/RS models. Table 8-1 summarizes the differences notice-
able in the Trend and Buffer Statistics panel. 

8.6.1 Measure Energy with a SSIM or LabMax Touch/Touch Pro and LM20 
Sensor

This section shows how to take Energy Measurements with use of a Lab-
Max-Pro SSIM or LabMax Touch/Touch Pro with an LM20 sensor. This is
typical behavior of the user interface and is not new.

NOTE: When a PowerMax-Pro USB/RS sensor is used, the software
operates in a similar manner. 

Table 8-1.  User Interface Differences for Long Pulse Energy Mode

User Interface LabMax-Pro SSIM or LabMax Touch 
and PowerMax-Pro USB/RS

Meterless Power Sensors 
(PowerMax USB/RS)

Trend Vertical Axis Power Watts Energy Joules

Trend Horizontal Axis Time Elapsed Seconds Pulse ID

Trigger Markers showing 
location of energy results

Yes (at the start and end of the 
Calculating phase) 

No

Status Line Messages 1. Searching for start of First Pulse
2. Calculating energy of Pulse
3. Searching for start of Next Pulse

1. Searching for start of First Pulse
2. Searching for start of Next Pulse
(No explicit feedback for Calcu-
lating vs. Searching)

Measurement Panel Energy Joules
• When it operates, shows most recent Energy measurement (or Mean

or other view per settings in View > Output Formats > Measurements).
• When stopped, periodically checks meter for recent energy measure-

ment.

Buffer Statistics Energy Joules 
• Shows statistics only for energy samples.
• Count = 0 prior to first energy measurement.

Histogram Energy Joules 
• Shows histogram only for energy samples.
• Counts = 0 prior to first energy measurement.
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8.6.1.1 Initial Configuration

To set initial configuration for an energy measurement:

1. Connect all equipment and open the Meter.

2. In the toolbar for the Coherent Meter Connection software:

a.) Go to the Home tab > Operating Mode section, and select
Energy Joules from the drop-down menu. The software sets
the meter to zero.

b.) Deselect the check box for High-Speed Mode.

3. On the on the Trigger tab, go to the Long Pulse Energy Mode section.
From the drop-down menu, select the appropriate Trigger level.
Figure 8-22 shows an example using the ‘Low’ setting:  

4. Right-click in the Trending window to display the context menu. Click
to select the menu options shown in Figure 8-23:  

Figure 8-22.  LPEM – Select Trigger Level

Figure 8-23.  LPEM – Select Trending Chart Menu Options



Measurement Modes 

163

The following examples chronicle how to measure energy data with use of
a PowerMax LM20 sensor. Figure 8-24 shows the initial screen (an empty
buffer) before pressing Start to measure energy.  

8.6.1.2 Start Energy Measurement

After you press Start, the display expands the signal to show the full range
of the data, as shown in Figure 8-25. 

This is done even though the signal actually is very small, generally under
4 mW.

The Count = 0, as no pulses have been detected and no energy measure-
ments have been made.  

8.6.1.3 Start of First Pulse Is Detected

After the start of the first pulse is detected, the Trending Chart shows a
marker where the pulse start was detected, as shown in Figure 8-26. 

This is displayed only if the menu option to Show Trigger Markers was first
selected. 

An Energy calculation is now in progress, searching for the end of the first
pulse.  

Figure 8-24.  LPEM – Initial Screen Before Start
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Figure 8-25.  LPEM – Start Energy Measurement

Figure 8-26.  LPEM – Start of First Pulse Detected
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8.6.1.4 End of First Pulse Is Detected

After the end of the first pulse is detected, the Trending window displays
two markers (shown in Figure 8-27) where the first pulse started and end-
ed. This is displayed only if the menu option to Show Trigger Markers was
first selected.  

The Count = 1 because one energy measurement has been made. The
Measurement window displays the current energy measurement. The
software now searches for the start of the next pulse.

8.6.1.5 Second Pulse Is Detected 

After second pulse is detected, the Measurement window shows most re-
cent energy reading, as shown in Figure 8-28. The Count = 2 in the Buffer
Statistics panel because two energy measurements have been made.  

Figure 8-27.  LPEM – End of First Pulse Detected
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8.6.1.6 Third Pulse is Detected

The software continues searching for the start of the next pulse. After third
pulse is detected and the user clicks Stop, the results shown in
Figure 8-29 are displayed.

• The Measurement window shows the final energy reading

• The Trending window displays Power vs. Time

• There are over 600 Power samples

• There are 3 energy Pulses / Measurements Samples

• There are 6 markers that show the starting and ending times of each
pulse
(only if the Show Trigger Markers menu option is selected)

The Statistics panel summarizes all 3 energy samples.  

Figure 8-28.  LPEM – Second Pulse Detected
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8.6.2 PowerMax-USB LM3 Sensor, Measure Power Data

Figure 8-30 shows a typical power measurement. This example uses a
PowerMax-USB LM3 sensor. 

You must select Highlight Sample Points in the Trending window context
menu to view all of the ‘first sample’ points, as shown in Figure 8-31. Oth-
erwise, the Trending window displays only a dashed horizontal line.  

Figure 8-29.  LPEM – Third Pulse Detected, User Clicks Stop
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Figure 8-30.  LPEM – Power Measurement for Sensor

Figure 8-31.  Select Highlight Sample Points
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8.6.3 PowerMax-USB LM3 Sensor, Measure Energy Data

The illustrations in this section show the Coherent Meter Connection soft-
ware with a meter reading Energy data.

8.6.3.1 Search for Start of First Pulse

Figure 8-32 shows an empty buffer, waiting for an energy measurement
while it searches for the start of the first pulse.  

8.6.3.2 Search for the First Pulse

The Trending chart generally shows lines connecting many samples.
However, when measuring energy with standard PowerMax or EnergyMax
sensors, the capture buffer contains only a single sample when the first
energy sample is measured. This first sample is displayed as an enlarged
point with an explicit label and a faint dashed line, as highlighted in
Figure 8-33.  

You must select Highlight Sample Points in the Trending window context
menu to view all of the ’first sample’ points (see Figure 8-31). Otherwise, if
this option is not selected, the Trending window displays only a dashed
horizontal line.

Figure 8-32.  LPEM – Empty Buffer
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8.6.3.3 Measure a Second Pulse

After a second pulse was measured, the samples are obvious, shown in
Figure 8-34.  

Figure 8-33.  LPEM – Measure First Sample
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8.6.3.4 After Several Pulses Are Measured

After several more pulses are measured, the Trending window displays
the sample points, shown in the example in Figure 8-35: 

Figure 8-34.  LPEM – Measure a Second Pulse
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Figure 8-35.  LPEM – Measure More Pulses
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I Safety and Compliance

This section describes general requirements for safety for persons when
using Coherent Meter Connection software with lasers when using Coher-
ent meters or sensor. 

I.1 Laser and Electrical Safety

Carefully review the laser and electrical safety information and precau-
tions provided by the equipment manufacturer of the devices used with
Coherent Meter Connection, including the use of shielding and personal
protective equipment.

WARNING!
Use of controls or adjustments or performance of procedures other
than those specified in this manual can result in exposure to
hazardous radiation.

WARNING!
When working with electrical power systems, the rules for electrical
safety must be strictly followed. Failure to do so can result in the
exposure to damaging levels of electricity.

I.2 Compliance

This section describes compliance with various government requirements
for safety, environmental regulations, and control law.

I.2.1 Laser Safety Standards

Following are sources for information about laser safety standards, as well
as safety equipment.
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I.2.1.1 Inside the United States:

The applicable United States Government laser safety requirements are
contained in 21 CFR Title 21 Chapter 1, Subchapter J, Part 1040 (“Perfor-
mance standards for light-emitting products”). The text of this federal stan-
dard is available from:

U.S. Food and Drug Administration
Center for Devices and Radiological Health (CDRH)
Document Mail Center – WO66-G609
Sliver Spring, MD 20993-0002

Website: www.fda.gov

I.2.1.2 Outside of the United States:

For jurisdictions outside of the United States:

Safety of laser products - Part 1: Equipment classification and require-
ments
IEC 60825-1 / EN 60825-1

Safety of laser products - Part 14: A user’s guide
IEC 60825-1 / EN 60825-1

Safety Requirements For Electrical Equipment For Measurement, Control
and Laboratory Use
IEC 61010-1 / EN 61010-1

I.2.1.3 Publications and Guidelines

International Electrotechnical Commission (IEC)
www.iec.ch

Safety of laser products - Part 1: Equipment classification and require-
ments
BS EN 60825-1
British Standard Institute
www.bsigroup.com

American National Standard for Safe Use of Lasers
ANSI Z136 Series
American National Standards Institute (ANSI)
www.ansi.org

A Guide for Control of Laser Hazards
American Conference of Governmental
and Industrial Hygienists (ACGIH)
www.acgih.org
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Laser Safety Guide
Laser Institute of America
www.lia.org

I.2.2 CE Marking

The European Community requirements for product safety are specified in
the Low-Voltage Directive (LVD) (published in 2014/35/EU).

This Direct ive requi res that  lasers comply wi th the standard
EN 61010-1/IEC 61010-1 “Safety Requirements For Electrical Equipment
For  Measurement ,  Cont ro l  and  Labora to ry  Use”  and
EN 60825-1/IEC 60825-1 “Safety of Laser Products”. Compliance with the
European requirements is certified by CE Marking.

I.2.3 Electromagnetic Compatibility

The primary issue for electromagnetic compatibility is to design covers,
shielding, grounding, routing of electrical cable assemblies, and control el-
ements with the correct safety features for a complete system.

Coherent products have been tested and shown to be compliant with the
relevant requirements of the following directives for Electromagnetic Com-
pat ib i l i ty EN 61326-1_Ed2:2013 ( IEC 61326-1_Ed2:2012) and
EN 61000-3-2:2006.

I.2.4 Environmental Compliance

This section shows compliance with various environmental regulatory di-
rectives to identify hazardous substances. 

I.2.4.1 EU REACH

Coherent products are classified as “articles” according to EU REACH
definition, as follows:

Article means an object which, during production, is given a special
shape, surface or design that determines its function to a greater
degree than its chemical composition. (REACH, Article 3(3))

Articles as defined by REACH regulations are exempt from registration as
long as they are not intended to release a chemical substance.

To the best of our knowledge, all Coherent product meet the definition of
“article” according to REACH.
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In addition, to the best of our knowledge, Coherent products do not con-
tain any Substances of Very High Concern (SVHC) above the legally man-
dated thresholds included in the REACH SVHC list, which is updated
every six months. The current SVHC list is available on-l ine at
https://echa.europa.eu/candidate-list-table.

I.2.4.2 RoHS Compliance

The European Union RoHS Directive EN 50581:2012 restricts the use of
certain hazardous substances in electrical and electronic equipment. Co-
herent is in compliance with this Directive and can provide RoHS certifica-
tion upon request. Compliance of this laser with the EMC requirements is
certified by the CE mark.

I.2.4.3 China RoHS Compliance

This section details compliance with the China RoHS (Restriction of Haz-
ardous Substances) Regulation SJ/T 11364-2014.

This Regulation restricts the use of certain hazardous substances in elec-
trical and electronic equipment. The China RoHS Regulation applies to
the production, sale, and import of products into the Peoples Republic of
China.

Any hazardous substances in Coherent products are shown on the materi-
al declaration table included with the equipment. 

The China RoHS Regulation also requires that the date of manufacture be
identified. This information is provided on the Certificate of Calibration
shipped with each product.

I.2.4.4 Waste Electrical and Electronic Equipment (WEEE, 2002)

The European Union Waste Electrical and Electronic Equipment (WEEE)
Directive (2012/19/EU) is represented by a crossed-out garbage container
label. The WEEE Directive applies to your product and any peripherals
marked with this symbol. 

Figure I-1.  WEEE Label
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The purpose of this directive is to minimize the disposal of WEEE as un-
sorted municipal waste and to facilitate its separate collection.

NOTICE
Do not dispose of these products as unsorted municipal waste.
Contract your local distributor for procedures for recycling this equip-
ment.
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II Warranty

Coherent laser meters and sensors come with a standard one-year war-
ranty.

For information about limited and extended device warranties as well as
warranty limitations, please refer to the product manuals for the devices
being used with the Coherent Meter Connection software.
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